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1 Notes, Cautions, and Warnings 

1.1 High voltage 
We do not recommend that you make any attempt to remove the instrument 
from its casing. Contact Bruker Technical Support for repairs. If you do attempt 
your own repairs, always turn the power off before attempting to remove any 
casing and before touching any connectors by hand or with electrically 
conductive tools. 

 

1.2 Laser Safety 
The nanoIR 3-s system incorporates three lasers. In normal operation, the user is protected from 
exposure to these lasers such that the class of the laser is as listed below:  

• a Class 2M diode laser at 670 nm 

• a Class 3R laser diode at 532 nm 

• a Class 4 tunable infrared source covering the range from 2.5 to 15 microns 

Caution: Use of controls or adjustments or performance of procedures other than those 
specified herein may result in hazardous laser energy exposure. Furthermore, the use of optical 
instruments with this product may increase eye hazard. DO NOT stare directly into the laser 
beam. 

 Class 2M lasers: Do not stare into beam or view directly with optical instruments. 

 Class 4 laser power up to 2.5 W and Class 3R green laser power up to 5 mW, could be 
accessible in the interior of this product.  

 Do not make any attempt to remove the instrument from its casing. Do not open the 
housing or covers on any part of this product. There are no user serviceable parts inside the 
system. If a laser malfunction is suspected, immediately contact Bruker Technical Support for 
repair or replacement. 

 Once a month, visually inspect the IR laser system housing to verify that no panels or 
covers are loose or distorted. It is important that there is no access to laser energy in the interior 
of the system. 
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In accordance with laser safety requirements, the following laser precautions are affixed to the 
system: 

 

 
 

 
 

 
 

        
 

  
 
 

A cover hazard label is located on the top 
cover of nanoIR 3-s housing. 

 

A laser hazard label is located on the back 
panel of the nanoIR 3-s housing. 
 

 

An aperture label is located above the 
aperture on the end panel of the IR laser 
system cover with an arrow pointing to the 
aperture. 

 

A laser hazard label is located on the end 
panel of the IR laser system cover beside 
the output aperture.  

 

Cover hazard labels are located on both sides 
of the IR system laser cover. 
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1.3 Notice 
The material contained in this manual, and in the online help for the software used to support 
this instrument, is believed adequate for the intended use of the instrument. If the instrument or 
procedures are used for purposes other than those specified herein, confirmation of their 
suitability must be obtained from Bruker Corporation. Otherwise, Bruker Corporation does not 
guarantee any results and assumes no obligation or liability.  

Bruker Corporation reserves the right to revise this document and to make changes without 
notice. Bruker Corporation may have patents, patent applications, trademarks, copyrights, or 
other intellectual property covering subject matter in this document.  

Except as expressly provided in a written license agreement from Bruker Corporation, the 
furnishing of this document does not provide any license to these patents, trademarks, 
copyrights, or other intellectual property. 

Bruker Corporation operating software, the associated manuals and online help, are proprietary 
and copyrighted. Purchasers are granted a license to use this software program on the module 
and controller with which they were purchased. These programs may not be duplicated by the 
purchaser without the prior written consent of Bruker Corporation. Each licensed program shall 
remain the exclusive property of Bruker Corporation, and no rights or licenses are granted to the 
purchaser other than as specified above. 

1.4 Trademarks 
ThermaLever™, nanoIR™, nanoIR™ 2, nanoIR™ 2-s, nanoIR™ 2-FS. nanoIR™ 3, nanoIR™ 3-s, 
afm+™, and Anasys™ are trademarks of Bruker Corporation.  

1.5 Contact 
For information about the nanoIR 3-s and its applications, see: 

• https://www.bruker.com/products/surface-and-dimensional-analysis/nanoscale-infrared-
spectrometers/anasys-nanoir3/overview.html  

To contact Bruker Technical Support, see:  

• https://www.bruker.com  

For information about our latest products and more, see: 

• https://www.bruker.com/products/surface-and-dimensional-analysis.html  

https://www.bruker.com/products/surface-and-dimensional-analysis/nanoscale-infrared-spectrometers/anasys-nanoir3/overview.html
https://www.bruker.com/products/surface-and-dimensional-analysis/nanoscale-infrared-spectrometers/anasys-nanoir3/overview.html
https://www.bruker.com/
https://www.bruker.com/products/surface-and-dimensional-analysis.html
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2 Introducing the nanoIR™ 3-s System 

2.1 Introduction 
The nanoIR™ 3-s  system from Bruker includes an Atomic Force Microscope (AFM) which can scan 
the sample and generate topography images of the sample. In addition, the nanoIR 3-s system 
supports both AFM-IR and s-SNOM mode.  

s-SNOM mode uses a continuous-wave (CW) laser source to excite a sample and the scattered 
light from the sample is detected as shown in Figure 2-1. The scattered light carries the sample 
dielectric function information. After interfering with a controlled reference beam, the s-SNOM 
signal can be analyzed to retrieve the sample refractive index n and absorption coefficient k. 

 

Figure 2-1: s-SNOM signal diagram and resulting optical spectrum 



nanoIR 3-s System User Guide 

 11 

AFM-IR mode uses a pulsed, tunable IR source to excite molecular absorption in a sample as 
shown in Figure 2-2. As the sample absorbs radiation, it heats up, leading to a local rapid thermal 
expansion of the sample. The rapid thermal expansion is sensed by the AFM cantilever due to the 
pulses exciting resonant oscillations of the cantilever. 

 

Figure 2-2: The AFM-IR technique showing sample configuration and data reduction 

Special data acquisition electronics measure the cantilever deflection in relation to the laser 
pulses. The deflection can be analyzed via Fourier techniques to extract the amplitudes and 
frequencies of the oscillations. Measuring the amplitude of the cantilever oscillation as a function 
of the source wavelength creates local absorption spectra that are similar to standard 
transmission spectra taken using an FTIR. In addition, the oscillation frequencies measured using 
the Fourier techniques can be used to measure the mechanical stiffness of the sample 
qualitatively. The IR source can also be tuned to a single wavelength to simultaneously map 
surface topography, mechanical properties, and IR absorption in selected absorption bands. 
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2.2 Components 
Your nanoIRTM 3-s system consists of the nanoIR electronics, the nanoIR 3-s microscope, the IR 
source, and a computer to operate the complete nanoIR 3-s system.  

 

Figure 2-3: NanoIR 3-s 

The nanoIR electronics include a Power Supply and Controller. The Power Supply supplies DC 
voltages to the Controller box and microscope. In addition, there are two separate small power 
supplies to power the motors and the MCT detector in the nanoIR 3-s system. 

The Controller has the DSP, FPGA, memory, communication interfaces, A/Ds and D/As inside. This 
box is responsible for communicating with the computer, setting the X, Y and Z voltages to the 
piezoelectric crystals and reading the signals which will ultimately be displayed in the software. 

The nanoIR 3-s microscope typically includes an infrared source which covers the range of the mid 
IR from 900 – 1800 cm-1. The light from this source is directed to the probe location using optics 
inside the cover to the rear of the AFM. In addition to these optics there is an infrared power 
meter and the electronics required to operate the nanoIR 3-s microscope. To the front of the 
system is a brightfield optical microscope to see the location of the probe on the sample surface 
and the AFM which can collect contact mode or tapping mode AFM images from the sample. The 
AFM includes a closed loop XY scan stage to accurately position the probe on the sample. 
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2.3 Specifications 
Specifications are subject to change. Table 1.1 contains specifications for the nanoIR 3-s system. 

Table 1.1: Product specifications 

XY Stage Range: ~7 x 8 mm 

Z Stage Range: >10 mm 

Optical field of view: ~900 x 600 microns low zoom,  
~300 x 200 microns high zoom 

Spatial Resolution (optics): ~1.5 µm 

XY Scan Range: 50 x 50 microns, closed loop control 

Z Scan Range: >7 microns 

Wavenumber Range: 900 – 1800 cm-1 (laser dependent) 

IR Source Linewidth: varies over the range, on average 4 cm-1 

2.4 Maintenance 
See Section 11.6, Training & Annual Maintenance for a schedule of preventative maintenance 
checks to perform. 

There are no user serviceable parts inside the system. Bruker Corporation suggests Annual Service 
visits to optimize the performance of the system and IR source and to return the system to 
original factory specifications. Please contact Bruker Corporation NanoIR Support 
(Support.NanoIR@Bruker.com) for additional information. 

All gasket material at the connections between the IR Source and the nanoIR 3-s system should 
be visually checked for any rips or wear to the exterior of the gasket, at least once per year. Do 
not remove any source or cover components during this visual inspection. Contact Bruker 
Corporation NanoIR Support if any external wear or tears are observed.  

The nanoIR 3-s system should be kept free of dust, and the system cover should remain closed 
when not being used. If cleaning is required, care needs to be taken. The system should not be 
connected to the main power supply during cleaning. Cleaning should first be attempted with a 
vacuum with soft brush on the intake hose, or other air source to remove any debris. If this does 
not work, the unit can be wiped down on the exterior using a cleaning cloth and isopropyl alcohol. 
Take care when doing this to prevent any liquid from going inside the enclosures of the system. 

For continued protection against the risk of fire, replace only with the same type and 
rating of fuses. All the fuses are 250 V type “T” slow blow fuses. The current rating of the 

fuses should be 5 A for both 100 and 115 VAC supplies and 2.5 A for a 235 VAC supply. 
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2.5 Installing the nanoIRTM 3-s System 
Before shipment, the nanoIR 3-s system is aligned and tested to meet all system specifications. 
The nanoIR 3-s system requires careful alignment during the installation process and so Bruker 
Corporation requires that the nanoIR 3-s system is only installed or moved by Bruker Corporation 
service personnel. 

2.5.1 Inspecting the System 
When you receive your nanoIR 3-s system, you will receive crates containing the optical table and 
nanoIR 3-s. Depending on the laser configuration, you may also receive crates containing lasers.  

Check each shipping container carefully for any signs of damage. Check the shock watch attached 
to each shipping crate. If any damage is observed or a shock watch is tripped, please take pictures 
of the damage and the tripped shock watch and contact Bruker Corporation immediately. 

We recommend that you do not open the shipping containers before the Bruker Corporation 
representative arrives for the installation. If there is a requirement to open the shipping 
containers, please check the parts received against the enclosed packing list. 

The nanoIR 3-s system is carefully packed and shipped in custom foam boxes and a wooden crate 
for the IR source. Please retain these shipping containers for shipping the unit for any required 
service (for example, to relocate the instrument). Also, the system should arrive ready for use, but 
if it does require any cleaning care needs to be taken. The system should not be connected to the 
main power supply during cleaning. Cleaning should first be attempted with compressed air 
sources to remove any debris. If this does not work, the unit can be wiped down on the exterior 
using a cleaning cloth and isopropyl alcohol. Take care when doing this to prevent any liquid from 
going inside of the enclosures of the system. 

2.5.2 Choosing a Location 
See Chapter 11, Facility Requirements for system location requirements and recommendations. 

The nanoIR electronics should be placed on a stable surface and the cooling vents on the side of 
the electronics boxes should not be blocked by any obstructions. Also the user needs to have easy 
access to the power switch and power cord on the back of the unit. 

The location of the nanoIR 3-s system is also of great importance. The primary signal in the AFM-
IR measurement, typically called the Deflection signal, is a high-resolution measurement over a 
relatively long time of the relative positions of the tip and sample. Loud noises, vibration, strong 
air currents or other effects can disturb the measurement. So the nanoIR 3-s system needs to be 
well-isolated from acoustic noise, mechanical vibration, air currents, and temperature variations. 

It is a requirement that the nanoIR 3-s system is installed on an air table. Bruker Corporation can 
supply a vibration isolation system if none is available. 

2.5.3 Power Requirements 
The nanoIR 3-s system is set in the factory to 100, 115 or 235 VAC (±10%), depending on the 
country and can be run from 50-60 Hz frequency. The unit requires minimal power (current less 
than 5 A for 100 or 115 VAC and less than 2.5 A for 235 VAC) and can typically be connected to a 
standard wall outlet. To minimize damage to the unit if installed in a location with intermittent 
power, we recommend a surge suppressor or in the extreme case a power conditioner. 
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3 General Experimental Procedure Overview  
The flow chart in Figure 3-1 shows the flow of an experiment on a nanoIR 3-s System. The 
highlighted portion, which is the part of the setup common to all experiments, is covered in this 
chapter. These setup steps apply regardless of the mode or application being used.  

 

Figure 3-1: nanoIR 3-s Experiment Flow Chart 

3.1  System Startup and Initialization 
Prepare the nanoIR 3-s system for use as follows: 

1. Power up the components as follows. We suggest leaving the nanoIR 3-s system power supply, 
computer, and chiller on at the end of typical workday, while de-initializing the software and 
turning off the laser. 

a. Turn on the computer and monitors. 

b. Turn on the nanoIR 3-s system using the rocker switch on the front of the Power Supply 
box. The power indicator light on the front of the nanoIR 3-s Controller and Power Supply 
boxes should illuminate. 

c. Turn on the Zurich Instruments lock-in amplifier (using the switch on the back) if it is off. 

d. Make sure the chiller for the laser is turned on. 

e. Turn on the IR laser source by pushing the power button on the laser unit. 
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2. Double-click the Analysis Studio icon  to open the software. The interface should look 
similar to the following window. If you have multiple lasers, please select the laser you would 
like to use via the Setup > Hardware menu option. 

 

Figure 3-2: Analysis Studio software upon opening 

3. Click the  Initialize icon to initialize the system.  

Initialization verifies communication between all the components and readies the hardware 
and software for use. The bottom status bar changes from “Not Initialized” to “Idle” when 
initialization is complete. (Initializing may take a couple of minutes.) 

4. If the controller was switched off when you began the initialization process, you will be 
prompted to initialize the Motorized Stages. Click Initialize. Click OK when the status changes 
for all the axes to “Initialized and ready”. 

 

Figure 3-3: Stage Initialization window 

5. Click OK when the status changes to “Initialized and ready” for all the axes. 

6. Select File > New or click  in the Document Window toolbar to open a new document. 
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After initialization is complete, the three main windows of Analysis Studio are open: the 
Document, Controls, and Microscope windows. The three windows can be positioned 
independently on the two monitors. For more information about these windows, see Section 8, 
Software Interface Reference. 

 

Figure 3-4: Document window in the Analysis Studio software 

 

Figure 3-5: Controls window in the Analysis Studio software 

 

Figure 3-6: Microscope window in the Analysis Studio software 
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3.2 AFM Preparation 
Any experiment performed on the nanoIR 3-s system begins by operating the AFM portion of the 
instrument. The highlighted steps below are covered in this section, while the details of getting a 
good AFM image are covered in Section 7, Standard AFM Modes. 

 

Figure 3-7: AFM Preparation Steps on the nanoIR 3-s system 

3.2.1 Selecting the Probe Type 

Select an appropriate probe for your experiment.  

• For s-SNOM experiments, use PR-EX-SNM-B or PR-EX-SNM-C probes. 

• AFM-IR measurements are made in contact mode, but can be made in conjunction with either 
type of AFM imaging. A different probe is used depending on the imaging mode. 

o For AFM-IR with Contact imaging, use PR-EX-nIR2 probes. 

o For AFM-IR with Tapping imaging, use PR-EX-TnIR-A or PR-EX-TnIR-C probes. 
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3.2.2 Installing a Probe 

 

Figure 3-8: A nanoIR 3-s probe (left) and a probe seated in the nanoIR 3-s head (right) 

To install a probe on the nanoIR 3-s system, follow these instructions: 

1. Make sure the head (or current probe) and sample have sufficient vertical clearance. There 
should be at least 1 mm of separation. Use the  Unload icon or the Z-Controls  button 
(circled below) in the Controls window to move the head and sample away from each other. 

 

2. Slide the head plate to the left as far as possible. 

3. Pivot the head up and back using the handle.  

o The back of the head should rest on the head plate. 

o Do not use the detector knob to move the head. 

o If an old probe is installed, remove it using tweezers. 
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4. Use tweezers to take a new probe from the box as follows. The probes are held in the box by 
a magnetic strip. 

a. Slide the half disc to the edge of the magnetic strip until a corner hangs slightly over the 
edge of the strip. 

b. Grasp the corner of the overhanging disc and lift the probe away from the magnetic strip. 
Do not allow the chip to touch anything; the cantilever is extremely fragile and can easily 
break. 

5. Place the probe into the recessed seat on the head as follows. The seat has magnets to hold 
the probe in place. 

a. Be careful not to touch the chip and cantilever. 

b. Place the half disc into the seat at an angle to accommodate where the tweezers are 
holding the disc, but enough into the seat so that the magnets hold the disc securely. 

c. Push on the flat edge of the disc near the protruding corner until the disc lines up properly 
with the seat. 

d. The probe must be seated firmly into the holder at the correct angle. 

 

Figure 3-9: Probe installation: The disc is initially placed at an angle (left) and then 
pushed flush with the seat for its final position (right). 

3.2.3 Installing a Sample 

Samples should be prepared according to the guidelines in Section 4.2, Sample Preparation for s-
SNOM and Section 5.2, Sample Preparation for AFM-IR. 

To install a sample in the nanoIR 3-s system, follow these instructions: 

1. Attach the sample to a sample puck. 

A sample is typically attached with an adhesive tab or epoxy to a sample puck so it will hold to 
the magnet in the nanoIR 3-s sample holder. For details, see Section 4.2, Sample Preparation 
for s-SNOM and Section 5.2, Sample Preparation for AFM-IR. 
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2. Place the sample puck on the sample holder. 

 

Figure 3-10: A sample holder with mounted sample 

3. Make sure the head is out of the way in its up position.  

4. Place the sample and its holder on the 3-point magnetic seat on the XY sample stage. Place 
the sample holder so that the flat side of the holder faces to the right as shown in the 
following figure. The sample holder should sit firmly on the three ball bearings in the seat.  

 

Figure 3-11: Sample and holder mounted in the nanoIR 3-s system 

Sample 

Sample 
Mount 

nanoIR 3 
Head 



AFM Preparation 

22 

5. Return the head into its operating position while checking for clearance as follows: 

a. Make sure there is ample clearance between the probe and sample, so they do not crash 
when the head is moved back. 

b. If there is any doubt about clearance, use the  Unload icon or the Z-Controls  button 

to move the head and sample away from each other. 

 

c. Use the head handle to pivot the head forward and down so that it seats firmly into the 3-
point kinematic mount on the head plate. 

d. Gradually slide the head plate back to the far right. 

e. If there is any doubt whether the tip could contact the sample, slide the head back to the 
left and create more clearance.  

3.2.4 Setting AFM Mode 

There are two basic imaging modes for AFM: Contact mode and Tapping mode. (For details see 
Section 7, Standard AFM Modes.) The appropriate AFM mode depends on the type of experiment 
being done. 

• s-SNOM experiments are done in Tapping mode.  

• AFM-IR measurements can be done in conjunction with either type of AFM imaging with the 
corresponding probe. 

To set the AFM Mode: 

1. Select the AFM imaging mode from the drop-down list in the Controls Window. 
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3.2.5 Using Load Wizard: Probe and Sample Alignment 

The next step is to align the probe and sample using the Optical view. The Load Wizard acts as a 
software guide through this process. 

To align the probe and sample, follow these instructions: 

1. Click the  Load icon to launch the Load Sample/Tip Wizard. 

 

2. Click Next on the introductory page of the wizard, which will walk you through loading and 
aligning the probe and sample. 

3. In the Microscope window, start with the widest optical field of view by clicking the Zoom Out 
icon (magnifier with a minus sign ) in the optical view.  

 

4. Within the wizard, you can zoom in or out, adjust the optical camera settings, and save 
images using the controls in the Camera area, which is available in all pages of the wizard. 

5. In the Load Sample/Tip wizard, use the Adjust Focus buttons to cause the probe tip to be in 
focus in the optical view. The sample will not be in focus when you focus on the probe tip. 
When the probe tip is in focus, click Next. 
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6. In the optical view, click on the probe tip at the location shown in the following figure. Or, 
type the X and Y offset values for the position of the probe tip in the Center Crosshairs page of 
the wizard. When the tip is centered in the optical view, click Next. 

 

7. Use the Focus on Sample buttons to adjust the focus downward until the sample surface 
comes into focus. Initially the optics focus moves down, but after a preset distance the sample 
moves up toward the probe. This allows you to bring the sample into focus without the probe 
being close to the sample surface. Be careful during this procedure; it is possible to bring the 
probe down too close to the sample surface and break it.  

 

8. Adjust the position to be analyzed using the Sample XY Navigation buttons. 

9. When you have finished focusing on the part of the sample you want to analyze, click Next. 

10. In the final page of the Load Sample/Tip wizard, click Approach Only. This moves the probe 
close to the sample surface but does not touch (engage) the surface.  

While it is possible to engage the tip on the surface at this point, there are still additional 
steps required to align the AFM laser and detector. 

The Load Sample/Tip wizard closes automatically after you click either of the buttons on this page.  
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3.2.6 Aligning AFM Laser and Detector 

The AFM laser is positioned onto the end of the cantilever. Then the reflected light from the 
cantilever is centered onto the AFM photodetector. 

 

Figure 3-12: The nanoIR 3-s head 

To align the AFM Laser, follow these instructions: 

1. Bring the red AFM laser spot into the optical field of view as follows: 

a. Click  Zoom on the Optical View to zoom out if needed. 

b. Move the AFM Laser Knobs on the top of the head to get the laser spot into view. 
▪ The left knob moves the laser left and right, perpendicular to the cantilever.  
▪ The right knob moves the laser up and down, parallel to the cantilever. 

2. Position the laser on the end of the cantilever using the AFM Laser Knobs. 

  

Figure 3-13: The Optical View before (left) and after (right) AFM laser alignment 
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3. Fine-tune the left/right laser position to maximize the Laser Sum. 

 

o Move the left knob back and forth to find the position where the Sum is greatest. 

o Keep the laser spot close to the end of the cantilever.  
 

To align the AFM Detector, follow these instructions: 

1. Adjust the AFM Detector Knob on the head until the Deflection indicator light is green. The 
Deflection is green for a small range of values around a target deflection that is different for 
each of the AFM modes: 

o Contact Deflection Target = –1 V  
o Tapping Deflection Target = 0 V 

 

2. Confirm that the Laser Sum is greater than 1 V. The exact value will depend on the type of 
cantilever and position of the laser. 

3.2.6.1 Troubleshooting: Low Laser Sum  

If the detector knob is turned in the wrong direction far enough, the Deflection can get to its 
target value (green indicator light) but with a very low Laser Sum. This means the reflected laser 
has been positioned completely off of the Detector and the system is measuring stray light. If so: 

• Turn the detector knob in the opposite direction until the Laser Sum starts to increase and 
then adjust the Deflection to its target. 

If a good Laser Sum and Deflection cannot be achieved, it may be because the reflected light from 
the cantilever is not at the right angle to make it to the detector. Try the following: 

• Check that the probe is correctly seated in the head and not tilted in the mount.  

• Clean the seat with a cotton swab and isopropyl alcohol. 

• If the above actions do not fix the problem, the cantilever may have been bent or the probe 
was not glued onto the half disc properly. If the reflecting laser light from the cantilever does 
not fall within the acceptable range for the detector, please contact Bruker Corporation for 
possible solutions or for a replacement probe. 
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3.2.7 Tuning Cantilever 

Cantilever tuning is done only for Tapping mode operation. It identifies the cantilever’s resonant 
frequency and sets the cantilever’s initial amplitude. If you are using Contact mode, skip to 
Section 3.2.8, Engaging the Probe. More details about Cantilever Tune are provided in Section 
7.2.3, Tune Cantilever for AFM Tapping Mode. 

• For parameter definitions, see AFM Controls > AFM Scan Panel > Cantilever Tune Window. 

• For more detailed usage instructions, see Tapping Operation > Tune Cantilever. 

To tune the cantilever, follow these instructions: 

1. Click the  Tune icon to open the Cantilever Tune window.  

 

2. Click Show advanced options to configure the Auto-Tune parameters. This is needed only 
when changing from one style of tapping probe to another. 

 

Figure 3-14: The standard settings for Auto-Tune 

3. Set the Center Frequency for the type of probe (see probe box): 

o 300 kHz for s-SNOM (PR-EX-SNM-B or PR-EX-SNM-C) or standard tapping (PR-EX-T125) 
probes 

o 60 kHz for tapping-compatible AFM-IR probes (PR-EX-TnIR-A or PR-EX-TnIR-C) 

4. Click the Auto-Tune button. 

 

Figure 3-15: Auto-Tune results 
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5. Verify that the Frequency is within the expected range. 

o 200 – 350 kHz for s-SNOM (PR-EX-SNM-B or PR-EX-SNM-C) or standard tapping (PR-EX-
T125) probes 

o 50 – 100 kHz for tapping-compatible AFM-IR probes (PR-EX-TnIR-A or PR-EX-TnIR-C) 

6. Verify that the Drive Strength is less than 50%. 

o If Drive Strength is greater than 50%, remove the probe and re-seat it or slightly shift its 
position in the seat. If this step does not help, remove the probe and use a Q-tip to 
carefully clean the mounting location using IPA or ethanol. Then re-align the AFM laser 
and detector and re-tune the cantilever. 

3.2.8 Engaging the Probe 

The last step is to bring the probe and sample into controlled contact. 

1. Click the Engage icon. 

 

o The probe and sample are slowly brought into contact. 

o When complete, the Engaged status button will flash green. 

 

o For details on the engage process, see Section 5.4.6, AFM Detector Alignment and Engage. 
The default settings accommodate most situations and generally do not need to be 
changed. 

Follow the instructions for AFM Imaging in Section 7.2.4, Acquire Image for AFM Tapping Mode to 
get a good image of the sample surface. 
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4 Using s-SNOM in Tapping Mode 

4.1 Experiment Workflow for s-SNOM 
The flow chart below shows the general steps of an s-SNOM experiment. The highlighted portion, 
which is specific to s-SNOM operation, is covered in this chapter. Once you have gained 
experience with the details involved in the various steps, the flow chart can serve as a checklist 
when conducting an experiment.  

 

Figure 4-1: s-SNOM Experiment Flow Chart 

4.2 Sample Preparation for s-SNOM 
A well-prepared sample is essential for successful s-SNOM results. Please read the information in 
this section before preparing a sample. 

The s-SNOM technique is a surface-sensitive technique, so the material of interest must be on the 
top surface of the sample.  

s-SNOM measures the relative signal between two materials (see Section 9.3, s-SNOM Theory), so 
a reference material must also be exposed on the top surface of the sample. The reference 
material should have a flat spectral response in the relevant wavenumber range. A typical 
reference material can be a clean gold or silicon surface.  

The material of interest and the reference material should be situated so they can be imaged 
together in the same AFM image (AFM range is 50 µm wide). The height difference between the 
two materials should be minimal. 
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An example of an ideal s-SNOM sample is a super thin (<50 nm) material of interest on top of a 
very smooth gold substrate (a gold layer on a silicon substrate). The material of interest does not 
completely cover the gold substrate, leaving exposed gold to be used as the reference material. 
The sample is attached with an adhesive tab to a sample puck so it can be held magnetically to 
the nanoIR 3-s sample holder. 

 

Figure 4-2: s-SNOM sample on magnetic sample holder 

Width: An ideal width for the sample is 10-15 mm. Samples up to 25 mm wide can be used, but 
material outside the center 8 x 8 mm area may not be accessible for measurements.  

Height: The entire sample must be less than 4 mm tall. This allows room for the sample to be 
attached to the 1 mm thick sample puck used to hold the sample to the magnetic holder. 

Thickness: Samples where the material of interest has a thickness ranging from 1 nm to 300 nm 
have been successfully measured. The optimal thickness will be different for each material type; 
in general, thinner samples are better.  

Substrate: If the material of interest is less than 50 nm thick, the s-SNOM signal can be enhanced 
by placing or preparing the material of interest on a flat gold substrate. Gold substrates can be 
purchased through Platypus Technologies, LLC (part number: Au.1000.SWTSG), or contact Bruker 
Corporation. 

Roughness: The smoother a sample is, the easier it is to get good results. It is best to keep the 
surface roughness below 50 nm RMS.  

Preparation Methods: If the sample is not already in a form that can be measured, successful 
preparation methods to date include: 

• Use a microtome (or cryo-microtome) to make thin sections, as is done for TEM, which are 
laid flat onto a substrate such as silicon wafer or gold coated silicon wafer. 

• Put a droplet of material onto a substrate to dry. (It is difficult to control the thickness with 
this method.) 

Sample Puck: Samples are attached to a magnetizable steel sample puck with epoxy or thin 
adhesive tabs. The sample must be firmly attached to the sample puck so that it will not shift 
position. Thick double-sided tape is not recommended as it often causes the sample position to 
drift over time. Sample pucks and adhesive tabs can be purchased from Bruker Corporation.  

Contamination: Samples must be kept clean. Do not to touch the top surface of a sample with 
bare fingers. Samples should be stored in a closed box to prevent contamination. Any loose 
particulates should be removed before analysis. 
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4.3 Software Setup for s-SNOM 
To prepare the system for use, follow the steps in Section 3.1, System Startup and Initialization. 

1. Once the instrument is initialized, load s-SNOM by choosing Setup > Control Panels > s-SNOM 
from the menus. This opens the s-SNOM mode panel in the Controls window. 

 

Figure 4-3: Enable s-SNOM mode in Analysis Studio 

2. To open a new document, select File > New from the menus or click the  New Document 
icon in the Document Window toolbar.  

After initialization is complete, the three main windows of Analysis Studio are open: the 
Document, Controls, and Microscope windows. See Section 8, Software Interface Reference. 

4.4 AFM Tapping Mode Preparation for s-SNOM 
To prepare AFM Tapping Mode for use with s-SNOM, follow the steps in Section 6, Using AFM-IR 
in Tapping Mode. Then, continue to Section 4.5, s-SNOM Preparation to prepare to use s-SNOM 
with AFM Tapping Mode. 
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4.5 s-SNOM Preparation 
Any s-SNOM experiment begins with the same steps, regardless of whether the measurement will 
gather s-SNOM images or spectra. Those common steps are covered in this section. 

 

Figure 4-4: s-SNOM Setup Steps 

4.5.1 IR Detector Preparation for s-SNOM 

Caution: All operators must be completely trained in and adhere to your institution’s 
protocol for handling liquid nitrogen. Read the Liquid Nitrogen Safety portion of the Notes, 
Cautions, and Warnings section at the beginning of this manual before proceeding. 

To prepare the IR detector, you will need to fill the MCT Detector with liquid nitrogen (LN) if 
needed. The MCT requires LN for proper operation. To prevent damage to the MCT, an automatic 
shutoff automatically powers the MCT down when no LN is present.  

To fill the MCT Detector with LN, follow these steps: 

1. Remove the cap from the top of the MCT. 

2. Insert the funnel that came with the nanoIR 3-s system. 

3. If the MCT is at room temperature it may splash. Begin by pouring in a small amount of LN 
into the funnel from a small cryogenic flask. Wait 1 minute before pouring more. This cools 
the MCT dewar flask and decreases the amount of splashing. 
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4. Pour LN slowly and in small increments into the funnel from a small cryogenic flask. 

 

Figure 4-5: Pouring liquid nitrogen into the MCT Detector 

5. Stop pouring as soon as LN spills out of the dewar (it is full) or if significant splashing occurs. 
Remove the funnel and replace the cap. 

6. Check the displayed MCT Intensity signal, which should be at 0 V when the detector is cold. 
The MCT Intensity can be monitored in the AFM Meter (see Section 8.1.4, AFM Meter). 

7. After filling with LN, the MCT needs to be replenished approximately every 8 hours. You may 
allow the MCT to run out of LN when the system is not in use and its power is turned off. Do 
not attempt to empty the LN from the MCT dewar. 
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4.5.2 Software Parameter Setup for s-SNOM 

As described in previous sections, set up the system for Tapping Mode AFM with an s-SNOM 
probe. In this section you will set initial s-SNOM parameters. 

To set the initial s-SNOM parameters, follow these steps: 

1. Use AFM imaging to find an area of the sample that has both the sample and reference 
material in it. 

2. If the s-SNOM Controls panel is not open, choose Setup > Control Panels > s-SNOM from the 
menus. 

 

Figure 4-6: s-SNOM Controls Panel 

3. Click the  icon to open the s-SNOM Settings dialog. 
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4. Set the following values: 

o Interferogram Sweep Start: 0 µm  
o Interferogram Sweep End: 9.8 µm  
o Interferogram Sweep Rate: 5 µm/s 
o Interferogram Sweep Data Rate: 512 pt/s 
o Meter Channel: MCT Intensity 
o Meter Range: 10 V 

5. Use the initial values similar to the following in the Power area. Your actual power settings 
depend on the IR source, wavenumber, and sample being used.  

o Source: 20% 
o Interferometer: 6% 

6. Use the following initial values in the Lock-in area. 

o Time Constant: 5 ms 

4.5.3 IR Laser Alignment for s-SNOM 

Once the AFM is engaged, the AFM Scan parameters can be set to define how the system will 
scan the sample surface. Then an AFM image on the area of interest can be captured.  

The next step in preparing the experiment is to align the IR laser by adjusting the parabolic mirror 

on the sample arm shown in Figure 4-7. This is performed using the  Align icon in the s-SNOM 

Controls toolbar. 

 

Figure 4-7: s-SNOM schematics 
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To align the IR laser, follow these steps: 

1. Before you align the IR laser, click the  Engage icon to engage the probe on the sample.  

 

When complete, the Engaged status button flashes green. 

 

For details on the engage process, see Section 5.4.6, AFM Detector Alignment and Engage. 
The default settings accommodate most situations and generally do not need to be changed. 

2. In the AFM Scan panel, click  Stop the scan in an appropriate area or use the  Target 
icon to position the probe before continuing with the IR alignment.  

It is easiest to align the IR laser if the probe is on a feature or area on the sample with a 
known IR absorption peak (wave number). If needed, take an AFM image to locate such a 
feature. 

      

Figure 4-8: The Target icon on the Microscope window (left) and the AFM probe 
location on the AFM image (right) here on a PMMA bead in the test sample 
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3. Click the  Align icon in the NanoIR panel toolbar of the Controls window. This opens the 

Center Align Laser page of the wizard. This page allows you to focus and align the visible 
alignment laser, which has the effect of focusing and aligning the invisible IR laser. 

 

4. If the green spot is too large or too dim (typically this is not the case), use the up and down 
arrows in the Adjust IR Focus section of the wizard to focus the green laser in the optical view. 
(Look for the green spot carefully, since many substrates are not very reflective of the green 
light. Try to avoid adjusting the IR Focus more than 500 points; the preset value should be 
relatively close.) This is a coarse focusing step; you will optimize the focus in Section 4.5.4, 
Signal Searching and Optimization for s-SNOM.  

   

Figure 4-9: Alignment laser unfocused (left) and focused (right) 

5. Once coarse focusing is done, use arrows in the Align Laser Navigation section of the wizard to 
move the laser spot in the optical view to the same location as the cantilever. This is a coarse 
alignment step; you will optimize the alignment in Section 4.5.4, Signal Searching and 
Optimization for s-SNOM.  

     

Figure 4-10: Alignment laser unaligned (left) and aligned (right) 



s-SNOM Preparation 

38 

4.5.4 Signal Searching and Optimization for s-SNOM 

Every time you change the probe or after a day of use, you should follow the steps in this section 
to optimize the IR position at the probe. 

1. Use the  Target icon on the AFM image to position the probe on the reference material 
(typically the substrate). 

2. Set the Wavenumber in the General area of the s-SNOM Controls panel in the Controls 
window: 

o s-SNOM imaging: Set the wavenumber that will be used in imaging, typically an absorption 
(resonance) of the sample material of interest. 

o s-SNOM spectra: Set a wavenumber within the spectrum range that is the strongest 
absorption of the sample material of interest. 

3. Click the  Optimize icon in the s-SNOM Controls area of the Controls window to open the 
Optimize IR Laser Position dialog. 

 

Figure 4-11: s-SNOM Optimize dialog (showing a 1-spot pattern) 
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4. Click the  Settings icon in the toolbar of this dialog. Set Input Channels 1-4 to NF2 (near 

field 2nd harmonic), NF2-R (near field 2nd harmonic magnitude), MCT Intensity, and Disabled. 
Then click Close. 

  

5. In the Optimize IR Laser Position dialog, make the following settings: 

o Drag the Size slider so that the image size is 200 µm x 200 µm. 
o Set Points/Line to 15. 
o Set Channel to NF2-R. 

6. Click the Scan button. This causes the IR beam to begin scanning the area around the probe. It 
is normal for there to be either 1 or 2 spots in the NF-R map. 

When the full scan completes, the position with the largest signal is automatically selected 
with the crosshairs. You can choose a different position by dragging the map. 

7. Change the channel to NF2 and confirm that the chosen location has a reasonably strong spot. 
It does not matter if the spot is positive (red) or negative (purple).  

  

Figure 4-12: Example of a 2-spot pattern 

Troubleshooting: If a good spot for optimizing is not found, troubleshoot as follows: 

• Make sure the MCT detector is cold. The MCT Intensity signal should be 0 V. (If warm, the 
MCT will power down and the Intensity signal will show 3 V.) 

• Increase the Scan Size to the maximum (400 um) and scan again. If a spot appears near the 
edge of the map, position the crosshairs on it. 

• Increase the Source power and scan again. 

• Change the channel to MCT Intensity. If there is a good spot in the MCT Intensity map, then 
position on that spot and rescan NF2-R at a higher Source power. 

8. Click Add or Update to add or replace the wavenumber and its xy position in the Optimized 
Positions list. 
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9. Click OK to save changes and exit the Optimize IR Laser Position dialog. 

10. Zero the Lock-in phase as follows: 

a. Click the  Interferogram icon in the s-SNOM Controls panel of the Controls window to 
collect an interferogram. 

b. Select Reflection under Imaging in the s-SNOM Controls pane.  

c. Click Zero Phase in the Lock-in area of the s-SNOM Controls panel. 

 

d. Click the  Interferogram icon again.  

e. Verify that the new interferogram (darker plot) has as much or more amplitude than 
before Zero Phase was clicked. 

11. Adjust the Source Power to keep the MCT Intensity near or below 5 V as follows. Increasing 
the Source Power can increase the amplitude of the interferograms and improve the quality 
of the resulting s-SNOM data. However, if Source Power is too high, the MCT Intensity may 
rise above 5 V, which will saturate the MCT detector. A Source Power near 20% is typical. 

a. In the Meter pane, set a Data Input to MCT Intensity. 

 

b. Click the  Interferogram icon again to collect NF interferograms. 

c. Increase the Source Power until either: 
▪ The NF interferogram signal-to-noise ratio stops improving significantly, or 
▪ The MCT Intensity reaches 5 V. 
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4.5.5 Interferometer Alignment for s-SNOM 

The next step in preparing the experiment is to align the reference optics by adjusting the mirror 
on the reference arm shown in Figure 4-13 so that the signal reaching the MCT detector is 
optimized. This is performed using the  icon in the s-SNOM Controls toolbar. 

 

Figure 4-13: s-SNOM schematics 

To align the Interferometer, follow these steps: 

1. Verify that the probe is still positioned on the reference material as follows: 

a. Scan enough lines of the AFM image to see the reference material. 

b. Use the  Target icon as needed to re-position the probe on the reference material. 
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2. Click the  Ref. Align icon in the s-SNOM Controls toolbar to open the Align Interferometer 

dialog. 

 

Figure 4-14: Align Interferometer dialog 

3. Set the following parameters in this dialog: 

o Time Constant: 5 ms  

o Sweep Rate: 20 µm/s  

o Data Rate: 500 pt/s 

o Ref. Am: 12% 

o Time Span: 40 s 

4. Click the  icon.  
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5. In the Align Settings dialog, set a channel to NF for Interferogram Channels, History / Strip 
Chart, and Meter. Then click Close. 

 

Figure 4-15: Align Settings dialog 

6. In the toolbar of the Align Interferometer dialog, click the  icon. 

7. Use the arrows to adjust the interferometer mirrors. The goal is to maximize the 

amplitude of the interferograms indicated in Figure 4-14. 

8. It is easiest to monitor the amplitude either by looking at the History plot or the Peak-to-Peak 
bar of the NF signal. 

9. Start with the arrows in the X direction and maximize the interferogram amplitude. 

10. Repeat for the Y direction. 

11. If the signal gets completely lost, click the Reset button to return the mirrors to the positions 
they had when the Align tool was opened. 

12. If after alignment the MCT Intensity is above 5 V, then decrease the Source Power as needed. 



Acquiring s-SNOM Data 

44 

4.5.6 Troubleshooting for s-SNOM 

If the quality of the interferograms is poor, consider the following when troubleshooting: 

• Increasing the Interferometer Power will increase the amplitude of the interferograms, but 
often does not improve the signal-to-noise ratio. It depends on the IR source and 
wavenumber being used. The Interferometer Power has a large effect on the MCT Intensity. 

a. Try making a small increase to the Interferometer Power 

b. Decrease the Source Power as needed to keep the MCT Intensity near or below 5 V. 

c. Check to see if the interferogram signal-to-noise ratio improves. If there is no 
improvement, set the Interferometer Power to 12%. 

• Optimize the X position of the MCT Detector. 

a. Record the current position of the X micrometer of the MCT Detector plate. 

b. While looking at the history plot of NF interferograms in the Align Tool, slowly move the X 
micrometer. 

c. Choose the X position that 1) maximizes the amplitude of the interferograms and 2) gets 
the vertical offset of interferograms closest to zero while still maintaining the maximum 
amplitude. 

d. If there is no improvement of the interferograms, then return X to its initial position. 

4.6 Acquiring s-SNOM Data 

4.6.1 s-SNOM Spectrum Acquisition 

This section covers the remaining steps to acquire an s-SNOM spectrum. You should have already 
performed the steps in Sections 4.2 through 4.5.5. 

1. Set the following Spectra parameters. 

o Resolution: 2 cm-1/pt 
o Start/End: desired wavenumber range within your IR source 

o Channel: NF2 (in  Settings) 

 

Figure 4-16: Spectra parameters in s-SNOM Controls panel 

2. Set the Reference Site as follows. 

a. Re-image the area where the reference material is located. 

b. Use the  Target to position the probe on the reference material.  
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c. Click the Set button in the s-SNOM Controls to write that position as the Reference Site. 

 

Figure 4-17: Reference Site coordinates and Set button 

3. Choose a sample measurement site. Use the  Target to place the probe on the desired 
sample site. 

4. Click the  Acquire icon. 

Interferograms for both the sample and reference sites are displayed in the s-SNOM Controls 
graph as they are acquired. Interferograms are not saved unless Keep Raw Data is selected. 
The spectrum is plotted in the document. It is comprised of s-SNOM Amplitude and s-SNOM 
Phase data which is derived from the interferograms.  

 Absorption: s-SNOM Phase = Δ Phase (Sample – Reference) 

 Reflection: s-SNOM Amplitude = Amplitude Ratio (Sample/Reference)  

 

Figure 4-18: s-SNOM spectrum and height image of purple membrane (on gold) 

5. During the spectrum collection, all the s-SNOM controls are grayed out except the Cancel 
button which may be used to stop the acquisition. 
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4.6.2 s-SNOM Image Acquisition 

This section covers the remaining steps to acquire s-SNOM images. You should have already 
performed the steps in Sections 4.2 through 4.5.5. 

1. Find a good area of the sample for s-SNOM imaging. The area should include both sample and 
reference materials. 

 

Figure 4-19: Height image of Graphene layers on Si (with contamination) 

2. Collect a high-quality AFM height image. For details, see Section 7.2.4, Acquire Image for AFM 
Tapping Mode. A Scan Rate between 0.5 and 1 Hz is generally good for s-SNOM imaging. 

3. Set the Wavenumber. Imaging is usually done at an absorption (resonance) of the sample 
material. 

 

4. Find the optical path difference (OPD) as follows: 

a. Position the probe on the reference material using the  Target icon. 

b. Choose Absorption or Reflection for the Imaging mode. Selecting “Absorption” images IR 
absorption; selecting “Reflection” images the index of refraction. See Section 9.4, s-SNOM 
Data Interpretation for details. 

 

c. Click the Find OPD button. An interferogram is collected, and the vertical cursor 
automatically sets an OPD that is appropriate for the imaging mode. 

 

Figure 4-20: Interferogram in s-SNOM Controls panel 
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5. Set up s-SNOM Interleave imaging as follows: 

a. Select s-SNOM Interleave imaging mode from the toolbar of the AFM Scan pane. 

 

When s-SNOM Interleave mode is on, each AFM scan line is performed twice. The Primary 
(first) line is scanned with the interferometer on; the Interleave (second) line is scanned 
with the interferometer blocked. The Interleave line measures the DC offset of the near 
field. This will be subtracted from the primary NF data to create the final s-SNOM image. 

b. In the Microscope Window, make the following settings: 
▪ Set Input to NF for two views. 
▪ For one input, set Direction to Primary Trace.  
▪ For the other input, set Direction to Interleave Trace.  
▪ For both inputs, set Capture fit to None. 

 

 

Figure 4-21: Input settings for s-SNOM interleave imaging in the Microscope window 

6. Click the  Scan icon and wait for the full scan to complete. 

7. Click  End of Frame icon to save the current image. 

 

Figure 4-22: s-SNOM Primary and Interleave images of Graphene layers on Si 
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8. Subtract the Interleave image from the Primary image in the Document as follows: 

a. Choose File > Document Properties from the menus in the Document Window to see the 
Scan Direction of each image. 

 

b. Click on the image name in the Channel List to edit the names of the images. 

c. Append “Primary” and “Interleave” to the image names as shown in Figure 4-23. 

d. Select Analysis > Analyze > Calculate Image > Subtract from the Document window menus. 

e. Drag NF Primary to the Subtract image A slot. 

f. Drag NF Interleave to the Subtract image B slot. 

 

Figure 4-23: Image selection for Subtraction Analysis 

g. Click the Continue button. 

h. Click the Accept button. 

The resulting subtracted image is the final s-SNOM Absorption (or Reflection) image. It is available 
in the Channel List with the name Sub(Image A, Image B). 
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5 Using AFM-IR in Contact Mode 
This chapter uses Resonance-Enhanced AFM-IR mode with Contact Mode AFM scanning, Fast 
Spectra IR collection mode, and PLL (phase-locked loop) autotuning. Procedures for other AFM, IR, 
and autotuning modes are provided in Chapter 7, Standard AFM Modes. 

5.1 Experiment Workflow for AFM-IR 
This section details the setup required for an AFM-IR experiment. The setup can be broken up 
into the following main stages:  

• Sample Preparation on page 50  

• System Preparation on page 51  

• AFM Preparation on page 54  

• IR Preparation on page 63   

• Acquiring IR Data on page 77  

Once you have gained experience with the various steps, you may find the outline below a useful 
checklist to refer to when setting up an experiment. 

 

    

Figure 5-1: The nanoIR 3-s system with head pivoted down (left) up (right) 
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5.2 Sample Preparation for AFM-IR 
A well-prepared sample is essential for successful AFM-IR results. Please read through this section 
before making a sample. 

1. Sample Placement 

a. Samples need to be placed or prepared on a sample puck which can be purchased from 
Bruker Corporation. The top of the sample must be kept clean – free of dust, fingerprints, 
or other contaminants as well as scratches. 

  

Figure 5-2: Sample puck with sample 

b. The measurable area of the sample is the center 6 mm by 8 mm area of the top face, so all 
areas of interest on the sample must be within this region. Sample material may extend 
beyond this region, but it will not be accessible for AFM-IR measurements without 
repositioning the sample mount. 

c. For thin film samples, they need to be in complete contact with the substrate. Try to avoid 
areas with bubbles and wrinkles as these areas may not be mechanically stable enough for 
AFM measurements and will typically provide poor spatial resolution with the AFM-IR 
technique due to poor heat dissipation. 

2. Sample Preparation Methods 

If the sample is not already in a form which can be measured, successful preparation methods to 
date include: 

a. Perform microtomy (or cryo-microtomy) to make thin sections, as is done for TEM, which 
are then laid flat onto the top face of a substrate such as a glass slide or silicon wafer. 

(Hint: In order to make the section stick to the substrate and have minimal wrinkles it is 
best to put a small water droplet on the substrate. The sections can then be transferred 
from the microtome to this droplet using an eyelash tool. After the sections are 
transferred to the water droplet, it is advised to guide the sections to the edge of the 
water droplet using an eyelash tool and guide it to the extent that it is somewhat stuck to 
the edge. By doing this, when the water recedes as the droplet evaporates in air, the 
section should adhere relatively flat to the substrate.) 

b. Spin coat onto the top face of a substrate such as a silicon wafer. 

c. Put a droplet of material onto the top face of a substrate to dry (it is hard to control the 
thickness with this method) 
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3. Sample Thickness 

Samples can be much thinner for Resonance Enhanced AFM-IR than with traditional AFM-
IR and still provide high SNR spectra and images. Resonance Enhanced AFM-IR samples 
should ideally be 20 nm to 500 nm thick. The lateral resolution generally improves as the 
sample gets thinner down to the limit of the AFM tip radius. 

In composite or multilayer samples, the thickness to consider is the top layer; so polymer 
films on glass slides or silicon wafers can be measured. 

The optimal thickness is different for each sample type, but in general the thinner the 
sample the better to a limit of ~20 nm. The AFM-IR signal is generated by the absorption 
of IR light in the sample leading to heating and expansion.  

If the sample is too thin, the expansion is too small to measure with the AFM detection. 
This typically starts to occur at thicknesses of <20 nm. If the sample is less than 20 nm 
thick, it may need to be prepared on a flat substrate that has high conductivity such as 
gold. This will increase the enhancement of the IR illumination providing a factor of 5 to 
10 increase in sensitivity. Gold substrates can be purchased through Platypus 
Technologies, LLC (Part number: Au.1000.SWTSG) or contact Bruker Corporation for help. 
Other metals can be used if they do not have an oxide and are very smooth (roughness < 1 
nm RMS). 

If the sample is too thick, the heat dissipation in the sample is too slow and this gives rise 
to poor spatial resolution as the heat spreads in the sample. Although you can measure 
samples that are thick (several mm) using AFM-IR, both the spatial resolution and any 
saturation effects similar to those seen with thick samples in transmission FTIR will be 
lessened if the sample is thinner (less than a few microns). We have successfully measured 
samples from 20 nm to 10 mm thick.  

4. Sample Roughness 

a. The smoother a sample is, the easier it will be to get good results. Generally it is best to 
keep the roughness below 100 nm RMS.  

5.3 System Preparation for AFM-IR 
To prepare the system for use, follow these steps: 

1. Power up the components. 

o Turn on the computer and monitors. 

o Turn on the nanoIR electronics via the rocker switch on the front of the Power Supply box. 
The power indicator lights on the fronts of the nanoIR Controller and Power Supply boxes 
should illuminate. 

o Turn on the chiller unit. 

o Turn on the IR laser by pushing the button on the laser unit. 
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2. Double-click the Analysis Studio icon  to open the software. The interface should look 
similar to the following window. 

 

Figure 5-3: Analysis Studio software upon opening 

3. Click the  Initialize icon on the top toolbar to initialize the system. This operation verifies 
communication between all the components and readies the hardware and software for use. 
The bottom status bar changes from “Not Initialized” to “Idle” when initialization is complete. 
(Initializing may take a couple of minutes.) 

If the controller was switched off when you began the initialization process, you will be 
prompted to initialize the Motorized Stages. Click Initialize. Select OK when the status changes 
for all the axes to “Initialized and ready”. 

 

Figure 5-4: Stage Initialization dialog 
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4. To open a new document, select New in the File menu or click the New Document icon  on 
the top toolbar. The interface has three windows: the Document, Controls, and Microscope 
windows. The three windows can be positioned independently on the two monitors. 

 

 

 

Figure 5-5: The three windows of the Analysis Studio software 

Document Window 

Controls Window 

Microscope Window 
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5.4 AFM Preparation 
An AFM-IR experiment begins with getting the AFM portion of the instrument operating. This 
includes installing a probe and sample, aligning the AFM laser and detector, and bringing the 
probe into controlled contact with the sample surface. 

5.4.1 AFM Probe Selection/Mounting 
It is best to use one of the pre-mounted probes available from Bruker Corporation, but it is 
possible to use your own cantilevers. The nanoIR 3-s probes from Bruker Corporation have been 
selected after testing a number of different probes and they are assembled on a fixture so that 
the probe is in the correct location. If you plan to use different probes, select a cantilever that is 
appropriate for contact mode AFM. We recommend a spring constant in the range from 0.05 to 
0.5 N/m. Both beam and triangular style cantilevers work well. Once the cantilever is on the 
surface of the sample, it is optimal if the contact resonance frequency of the cantilever is above 
50 kHz. The contact resonance depends on both the cantilever and sample stiffness, so there is 
not an exact translation from the free-air to contact resonant frequencies. As a general guideline, 
a free-air resonance of 10 kHz or higher usually works well. We use both uncoated cantilevers and 
cantilevers with a reflective coating.  

5.4.2 ARM Probe Installation  

   

Figure 5-6: A nanoIR 3-s probe both on and off the head 

To install a probe on the nanoIR 3-s system, follow these instructions: 

1. For the modes described in this procedure, we suggest using a gold-coated contact mode 
nanoIR probe (model PR-EX-nIR2-10).  

2. Make sure the probe and sample have a good amount of separation, at least 1 mm. This can 

be done using either the  Unload button or using the Z-Controls  Up arrow to move the 
current probe away from the sample 

3. Slide the AFM head to the left on the stage until it is moved as far as possible. 

Optics 

Handle Detector Knob 

Half  
Disc Chip 

Cantilever 

Probe 
in Seat 

 
nanoIR 3-s 

Head 
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4. Pivot the head up and back using the handle (rod sticking out on the bottom right front of the 
head). Do not use the Detector Knob to flip the head. The back edge of the head should now 
rest on the black plate. 

5. Using tweezers, remove a probe from the box in which they are shipped. The probes are held 
in the box by magnetic tape. The easiest way to remove a probe is to use tweezers to slide the 
half disc to the edge of the magnet until it hangs slightly over the edge. Then grasp the corner 
of the disc with the tweezers and lift the probe away from the plate. When handling the 
probe be careful not to allow the cantilever chip to contact anything. The cantilever itself is 
extremely fragile and can easily break off the chip. 

6. Place the probe into the recessed semi-circular seat on the underside of the head. The seat 
contains magnets to hold the probe firmly in place. 

7. Place the half disc in slightly rotated at first to accommodate where the tweezers are holding 
the disc. Once the magnet holds the disc securely, push on the corner of the flat edge of the 
disc with the tweezers until the disc lines up properly with the seat. Be careful not to touch 
the cantilever chip. For accurate measurements, the probe must be seated firmly into the 
holder at the correct angle. 

   

Figure 5-7: A probe in the seat. The disc is initially placed at an angle (left) and then 
pushed flush with the seat for its final position (right). 

5.4.3 AFM Sample Installation 
Follow these steps to install a sample: 

1. Prepare the sample as described in Section 5.2, Sample Preparation.  

2. Typically samples are attached to a sample puck which is a thin magnetic stainless steel disk. 
Samples can be attached to the sample mount using epoxy or thin double-sided tape 
(Adhesive tabs). Care should be taken when attaching the sample to the sample mount so 
that it is firmly attached and will not shift position. It is recommended that the user not use 
thick double-sided tape as this may cause the sample to drift in position. Sample mounts and 
Adhesive tabs can be purchased from Bruker Corporation. Be very careful not to touch the top 
surface of the sample. Also samples should be stored in a closed box to prevent 
contamination and any loose particulates should be removed before analysis. 
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Figure 5-8: A sample holder (left) and a sample mounted on a sample holder (right) 

3. Make sure the head is out of the way in its up position.  

4. Place the sample and its holder on the 3-point magnetic seat on the XY sample stage. Place 
the sample holder so that the flat side of the holder faces to the right as shown in the 
following figure. The sample holder should sit firmly on the three ball bearings in the seat.  

 

Figure 5-9: Sample and holder mounted in the nanoIR 3-s system 

5. There needs to be enough clearance between the probe and sample so that they do not 
touch when the head is moved back into position. If a sample with a similar height is being 

measured and the  command was used before moving the head out of position this 

should be safe. Alternatively, the  Up arrow for the Z-Controls can be used to increase the 
tip-sample distance by a few millimeters. The safest route is to increase the distance to its full 
range before moving the head back into position. 

6. Lower the head back into position on the head mount checking to make sure that the head 
kinematic mount is firmly seated.  

7. Gradually slide the head back to the far right. As you do this make sure the probe will clear 
the sample surface. This can be done by moving your head so that your line of sight is in line 
with the top of the sample. Slowly slide the head to the right towards the sample while 
watching the gap between the probe and sample. If there is any doubt whether the tip will 
contact the sample, slide the head back to the left and use the Z Controls in the AFM Probe 
panel to get more clearance as needed.  

Sample 

Sample 
Mount 

nanoIR 3-s 
Head 
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5.4.4 AFM Probe/Sample Alignment 
Once a probe and sample are mounted, the next step is to align the AFM probe within the Optics 
field of view. Follow these steps: 

1. Make sure that Contact Mode is selected in the AFM Scan panel of the Controls window. 
(Other modes are described elsewhere in this manual.) 

 

2. Click the  Load command in the AFM Probe panel of the Controls window.  

 

3. This opens the Load Sample/Tip wizard, which will walk you through loading and aligning the 
probe and sample. Click Next. 

 

4. In the Microscope window, start with the widest optical field of view by clicking the Zoom Out 
icon (magnifier with a minus sign ) in the optical view.  
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5. Within the wizard, you can zoom in or out, adjust the optical camera settings, and save 
images using the controls in the Camera area, which is available in all pages of the wizard. 

6. In the Load Sample/Tip wizard, use the Adjust Focus buttons to cause the probe tip to be in 
focus in the optical view. The sample will not be in focus when you focus on the probe tip. 
When the probe tip is in focus, click Next. 

  

7. In the optical view, click on the probe tip at the location shown in the following figure. Or, 
type the X and Y offset values for the position of the probe tip in the Center Crosshairs page of 
the wizard. When the tip is centered in the optical view, click Next. 

 



nanoIR 3-s System User Guide 

 59 

8. Use the Focus on Sample buttons to adjust the focus downward until the sample surface 
comes into focus. Initially the optics focus moves down, but after a preset distance the sample 
moves up toward the probe. This allows you to bring the sample into focus without the probe 
being close to the sample surface. Be careful during this procedure; it is possible to bring the 
probe too close to the sample surface and break it.  

 

9. Adjust the position to be analyzed using the Sample XY Navigation buttons. 

10. When you have finished focusing on the part of the sample you want to analyze, click Next. 

11. In the final page of the Load Sample/Tip wizard, click Approach Only. This moves the probe 
close to the sample surface but does not touch (engage) the surface.  

 

While it is possible to engage the tip on the surface at this point, there are still additional 
steps required to align the AFM laser and detector. 

The Load Sample/Tip wizard closes automatically after you click either of the buttons on this page.  
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5.4.5 AFM Laser Alignment 
At this point, the position of the AFM laser needs to be centered on the end of the cantilever. 

  

Figure 5-10: The nanoIR 3-s head 

Follow these steps: 

1. Adjust the two AFM Laser knobs on the top of the nanoIR head to move the AFM laser spot 
onto the cantilever. Move the laser spot into the optical view, and then position it on the end 
of the cantilever as shown in the following figure. This method works best if the cantilever is 
not far from the sample surface. (The left knob moves the AFM laser spot perpendicular to 
the cantilever. The right knob moves the AFM laser spot parallel to the cantilever.) 

    

Figure 5-11: Optical view showing the AFM laser spot to the side of the cantilever (left) 
and correctly centered on the end of the cantilever (right) 
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2. Once the laser spot looks correctly positioned on the cantilever, fine tune the position by 
watching the Laser Sum value in the AFM Probe Meter panel. This value should be maximized 
while keeping the laser spot close to the end of the cantilever in the optical view. You can get 
a large Laser Sum value by moving the laser spot close to the base of the cantilever, but this is 
not a desirable location for the laser since it will decrease the sensitivity of the system to the 
deflection of the cantilever. The laser spot should be located close to the end of the cantilever. 
The picture to the right in the previous figure shows an ideal location for the laser spot. 

 

5.4.6 AFM Detector Alignment and Engage 
After aligning the AFM laser on the cantilever, the next step is to center the reflected light from 
the cantilever onto the detector. Follow these steps:  

1. While looking at the AFM Probe panel, adjust the detector knob on the front of the head to 
achieve a green indicator on the Deflection light bar. (The specific value of the deflection that 
corresponds to the green light is set in the Setup>Engage Settings. The default is –1 V and 
generally does not need to be changed.) 

 

Figure 5-12: The lightbars in the AFM Probe panel 

2. Once the deflection light bar is green, confirm that the Laser Sum value is greater than 1 V. 
The exact value will depend on the type of cantilever loaded and the position of the laser spot 
on the cantilever. 

3. If you turn the Detector knob the wrong direction for a significant amount, it is possible to 
adjust the Deflection signal to the correct value and the center green light will appear but 
with a low Laser Sum value. This is because the reflected laser spot has been positioned 
completely off the Detector and the system is measuring the stray light reflected to the 
Detector. In this case the Laser Sum will be significantly less than 1 V. Turn the detector in the 
opposite direction until the Laser Sum starts to increase and then center the deflection signal. 

4. If a good Laser Sum and Deflection signal cannot be achieved, it may be because the reflected 
light from the cantilever is not reflecting to the Detector. Check that the probe is correctly 
seated in the head and not tilted in the mount. If it is mounted correctly, it is possible that the 
cantilever is bent or that the probe was glued onto the probe mount with an incorrect angle. 
If the laser light reflecting from the cantilever does not fall within the acceptable range for the 
detector, please contact Bruker Corporation for possible solutions or for a replacement probe. 
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5. Close the instrument lid to cover the nanoIR 3-s.  

6. Click the  Engage button in the AFM Probe toolbar to bring the probe into contact with the 

sample surface. This starts the computer-controlled approach to slowly bring the probe into 
contact with the sample surface. 

7. Once the probe successfully contacts the surface the Engaged status button in the AFM Probe 
panel turns green (and the Feedback status in the AFM Scan panel will be on).  

 

8. Choose Setup>Engage Settings from the menus in the Document window to further control 
the Engage process. The default settings will accommodate most situations and do not 
generally need to be changed. 

9. At this point, you can perform an AFM scan by clicking the  Scan icon in the AFM Scan 

panel. 
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5.5 IR Preparation 
Once the AFM is engaged, the AFM Scan parameters can be set to define how the system will 
scan the sample surface. Then an AFM image on the area of interest can be captured.  

The final step in preparing the experiment is to align the IR laser and optimize the signal. 

5.5.1 IR Laser Alignment 

Note:  The instrument contains two coaligned lasers pointed at and focused on the same 
location: the tunable IR laser for measurement and a green alignment laser to make 
the focus point visible.  

Follow these steps to align the IR laser: 

1. Before you align the IR laser, the probe must be engaged on the sample as described in the 
previous section. 

2. In the AFM Scan panel,  Stop the scan in an appropriate area or use the  Target icon to 
place the probe before continuing with the IR alignment.  

It is easiest to align the IR laser if the probe is on a feature or area on the sample with a 
known IR absorption peak (wave number). If needed, take an AFM image to locate such a 
feature. 

      

Figure 5-13: The Target icon on the Microscope window and the AFM probe location on 
the AFM image (here on a PMMA bead in the test sample) 
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3. Click  Align in the NanoIR panel toolbar. This opens the Center Align Laser page of the 

wizard. The wizard allows you to focus and align the visible alignment laser, which has the 
effect of focusing and aligning the invisible IR laser. 

 

4. If the green spot is too large or too dim (typically this is not the case), use the up and down 
arrows in the Adjust IR Focus section of the wizard to focus the IR alignment laser in the 
optical view. This is a coarse focusing step; you can optimize the focus in steps that follow. 

   

Figure 5-14: Alignment laser unfocused (left) and focused (right) 

5. Use the arrows in the Align Laser Navigation section of the wizard to move the laser spot in 
the optical view to the same location as the cantilever. This is a coarse alignment step; you 
will optimize the alignment in steps that follow.  

     

Figure 5-15: Alignment laser unaligned (left) and aligned (right) 
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6. In the nanoIR panel of the Controls window, set the mode to Fast Spectra. 

 

Figure 5-16: The NanoIR panel toolbar in Fast Spectra mode 

7. In the NanoIR panel, adjust the General parameters. (For more about the nanoIR parameters, 
see Section 8.3.1, NanoIR Panel.) 

o Set Wavenumber to a value that corresponds with a large IR absorption band at the 
probe’s location on your sample.  

For the test sample, use the carbonyl peak at 1730 cm-1, on a PMMA bead. 

If the sample is totally unknown, try a common absorption peak that the IR source covers, 
such as 2920, 1720 or 1450 cm-1. 

o Set Co-averages to 128x.  

o Set the initial laser Power to a few percent, for example, 5%. 

o Set Pulse Rate to ~180 kHz. For nanoIR 3-s contact probes (PR-EX-nIR2-10) the 2nd contact 
resonance near 180 kHz is recommended. Other probes will have different resonant 
frequencies. The Pulse Rate will be fine-tuned later in this procedure.  

o Set Duty Cycle to a value from 2% to 4%. 

o Set Freq. Center equal to the initial Pulse Rate. 

o Set Freq. Window to 50 kHz. 

o Turn on the Band Pass Filter. The band-pass filter decreases the signal contribution from 
frequencies outside the window giving the data a better signal to noise ratio.  

o The Filter Strength was previously set here. It is now set via a configuration file and should 
not need to change. However, if you see unwanted artifacts in the FFT trace, the filter 
strength may be too large. 

 

Figure 5-17: General parameters in the nanoIR panel 
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8. Click the  Start IR icon to turn the IR laser on. The Laser status button flashes yellow.  

9. Increase the Power gradually until some probe oscillation is observed, up to a maximum 
power of 20%. 

10. Look at the nanoIR meter graphs. The IR signal appears as a continuous periodic oscillation in 
the Deflection graph (left) and a distinct peak in the FFT graph (right) at the frequency of the 
pulse rate.  

 

Figure 5-18: The nanoIR Meter showing a weak IR signal before optimization 

When the probe is on a place in the sample that is absorbing IR, the deflection should have a 
consistent waveform and the FFT should have one or more clear peaks. This is the signal we 
are looking for.  

 

Figure 5-19: The nanoIR Meter showing a strong IR signal 

The frequency of the FFT peaks is primarily determined by the type of cantilever used and is 
also influenced by the mechanical properties of the sample. The nanoIR 3-s cantilevers have a 
fundamental contact resonance around 60 kHz. Typically we use the 2nd mode of the 
cantilever but may also use the 3rd. The higher the mode selected, the lower the amplitude of 
oscillation but typically also the lower the noise level of the signal when there is no absorption. 
This can provide a higher signal to noise ratio.  

Only when the Freq. Center and Freq. Window parameters are set appropriately is the IR 
amplitude data displayed in the red Amp bar meaningful.  

Deflection FFT 
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11. Click the  Optimize icon in the nanoIR panel. The IR Optimize window helps you search for 
the IR spot. It moves motorized mirrors that shift the position of the IR spot on the sample.  

12. Using the slider bar near the top of the IR Optimize window, select a large search area,  
400 µm x 400 µm. 

13. Click the Scan button.  

14. When the scan is complete, click OK. The resulting image is a map of the Amplitude 2 signal at 
each x and y location. The software selects the location with the largest signal and centers it 
under the cross hair.  

 

Figure 5-20: The Optimize window used for a large 400 µm scan 

15. If there is no obvious spot in the Optimize view, increase the IR Power setting and scan again. 
You can increase the power by a factor of two until there is a clear spot in the Optimize view.  

16. To accept the location indicated by the crosshair, click the Add button (or the Update button 
if previous locations are already stored).  

In Fast Spectra mode, each laser/stage combination should have only one optimized position. 
Each stage is represented by a horizontal bar at the top of the Optimize window. Only one 
wavenumber from each stage should be added to the Optimized IR Positions. 
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17. Move the slider to 100 µm x 100 µm. Then click Scan.  

 

Figure 5-21: The Optimize window used for a higher-resolution scan 

18. If an offset is larger than 200 µm, it is important to check the position of the probe in the 
optics field of view and reposition the probe. To clear large offsets, go into the IR Optimize 
window and select all the offsets from the “Optimized IR Positions” list, then click the Remove 
button. Exit the window with the OK button. 

To cancel any changes made while in the IR Optimize window, exit the Optimize window using the 
Cancel button. 

Note that offsets generated in the IR Optimize window are displayed both in this window and on 
the status bar at the bottom of the Document window.  

If there is still no signal, possible causes not related to the IR alignment are: 

• The shutter is down on the laser housing. 

• The system front cover is open or slightly open, activating the safety interlock. 

• The sample is not absorptive (enough) at this location or at this wave number.  

o Do an AFM image to check that the probe has not drifted from the desired area of the 
sample (due to thermal drift). 

o Try a different wavenumber. 

• The sample is too thick or too thin. Measure the thickness of the sample with the AFM by 
moving to an edge of the section if possible. See the thickness guidelines in Section 5.2, 
Sample Preparation. 

• If there is still no signal, refer to Section 5.5.6, Troubleshooting the AFM-IR Signal. 
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5.5.2 IR Laser Pulse Tuning 
The Laser Pulse Tune window contains parameters that control setting the Pulse Rate to match 
the contact resonance of the cantilever. A number of these parameters are duplicated in the 
NanoIR window and are initially set by the values in that window. 

 

Figure 5-22: The Laser Pulse Tune window 

To tune the pulse rate, follow these steps: 

1. Click the  Pulse Tune icon in the NanoIR panel to open the Laser Pulse Tune window. 

 

2. Set Tune Range to 200 kHz (or less if you have a good idea where the resonance frequency is 
located).  

3. Click the Acquire button. 

The pulse rate is swept through the range defined by the Pulse Rate and Tune Range. The plot 
shows the probes resulting amplitude, Amp2.  

4. Slide the vertical green marker to the peak. The 2nd contact resonance of nanoIR 3-s probes 
should be between 150-250 kHz.  

5. Set Tune Range to 50 kHz, so that you can locate the resonance frequency more precisely. 

6. Click Acquire. 

7. Slide the vertical green marker to the peak. 
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Note: The steps that follow enable PLL autotuning, which is recommended when collecting 
IR images, spectra, and spectral arrays. If you want to leave PLL mode disabled, skip 
to the last step of this procedure. When PLL mode is enabled, it is on across all IR 
modes. 

8. Enable PLL (phase-locked loop) mode in the Auto-Tune area. These parameters control 
functions that maintain the Pulse Rate at the contact resonance during IR imaging or spectra 
collection. For details about auto-tune parameters, see Section 8.3.3.2, Auto-Tune Parameters  

o In PLL mode, a feedback loop is used to track the contact resonance frequency. The Pulse 
Rate is adjusted to maintain a constant Phase 2 signal. Amplitude 2 is the IR absorption 
data and PLL Frequency (previously called Frequency 2) is the contact resonance data. PLL 
mode imaging can be done much faster than Chirp mode, with a typical scan rate of 0.5 Hz. 

9. Set the parameters in the Auto-Tune/PLL area. For more information about these parameters, 
see Section 8.3.3, Laser Pulse Tune . 

 
▪ Enable is unchecked 
▪ Setpoint = 0 deg 
▪ iGain = 0.1 
▪ pGain = 20 

10. Click Acquire. 

11. In PLL mode, the pulse tune displays Amplitude 2 and Phase 2. 

 

Figure 5-23: Setting the PLL Auto-Tune Threshold 
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12. If the peak has moved, slide the vertical green marker to the peak.  

13. Adjust the parameters in the Auto-Tune/General area: 
▪ Set Threshold to a value just above the noise level (0.03 V in the above figure). 
▪ Set Maximum to the contact resonance + 30 kHz 
▪ Set Minimum to the contact resonance - 30 kHz 

14. Click Zero in the PLL area. This sets the Phase Offset, so the current phase signal is zero. 

15. Check Enable to activate using PLL feedback for autotuning. 

 

16. Click OK. This exits the window and saves the Pulse Rate to the NanoIR parameters 

5.5.3 IR Laser Focusing 

The next step is to optimize the IR focus. This step is not typically needed. You should perform 
these steps if the green laser spot is significantly larger than the typical size (100 µm x 50 µm). 

Changing the IR focus also shifts the optimal X and Y IR alignment, so this is an iterative process 
between the two types of adjustments.  

Follow these steps to focus the IR laser. 

1. Click the  Optimize icon in the nanoIR panel.  

2. Set Focus Capture parameters. Number specifies how many different focus images to capture. 
Start and End specify the range of focus positions to try. 

 

3. Click on Tools and choose Focus Capture from the drop-down menu.  
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4. The Optimize tool adjusts the focus through the specified range and captures images and data 
specified by the channels selected.  

5. Look at the graph and the images. Highlight the focus image that corresponds to the highest 
Peak Value (orange trace) and has a reasonably small Diameter (blue trace). 

   
6. Click OK to save the focus position you selected. 

7. Adjust the Power using the controls in the nanoIR panel so that the red meter bar is 
approximately half filled. 

 

Figure 5-24: Ideal AFM-IR signal after Pulse Tune, Optimize, and power adjustments 

8. After you have chosen the final focus, you may need to adjust the Power so that the signal is 
not too large and there is not too much sample heating leading to the probe penetrating the 
sample and making a hole. You can also adjust the signal by changing the Gain slider to the 
left of the IR Meter panel. Both the Power and the Gain amplify the deflection signal, but the 
best signal to noise is achieved with high laser power (rather than high gain).  

Melting is observed as a small pit in the sample surface after a spectrum is performed. 
Melting occurs more easily on thick samples. The following table lists typical values for the 
Power for the 1200 to 1800 cm-1 wave number range as a function of sample thickness.  

 

Figure 5-25: Typical Power for the 1200 to 1800 cm-1 wave number range 

Thickness Typical Power 

Standard 
(ex. 400 nm) 

4 % 

Thick  
(ex. 1 µm) 

1 % 

Thin  
(ex. 100 nm) 

8 % 
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9. Set Spectra parameters in the nanoIR panel. Resolution is typically 2 or 4 cm-1/pt. 

 

5.5.4 IR Background Calibration 

The IR background is used for power normalization across the spectrum. 

We recommend that you collect the IR background frequently. This is especially critical if the 
system is not purged to a well-controlled humidity to help compensate for shifting atmospheric 
water absorption bands. For more information, see Section 8.3.2, IR Background Calibration. 

1. In the Analysis Studio window, choose Tools>IR Background Calibration>New from the menus.  

The parameters are set automatically. Most background parameters need to exactly match 
the spectrum, except for the Power which needs to be 100% when collecting a background. 

2. Click Acquire. After the background has been collected, you should see graphs similar to the 
following: 

 

3. Click Save and save the background data to a file. The default file extension is *.irb.) 

4. When you collect a background, it is automatically loaded and will be used on any subsequent 
spectra until a new background is loaded. 
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5.5.4.1 More About Background Calibration 

A background should be collected in the same mode as the spectra it will be used for, either 
Stepped or Fast.  

For Fast Spectra, the background can be performed in less than a minute and so we recommend 
frequent collection of backgrounds to accurately compensate for power variations. This is 
especially true if the system is not purged to a well-controlled humidity level. The humidity level 
inside the system can be monitored by opening the Humidity data channel in the Meter view. The 
QCL source typically used in Resonance Enhanced mode has a very narrow linewidth (<1 cm-1) 
which can make atmospheric water absorption bands problematic. Any changes in humidity or 
temperature will shift the water bands and make the background compensation not as effective 
causing sharp spikes in the spectra especially in the 1400 – 1750 cm-1 range.  

Acquire a background by going choosing Tools → IR Background Calibration → New from the 
menus in the Document window. 

 

Figure 5-26: The Collect background window 

The parameters in the Collect background window are mostly imported from the NanoIR window 
settings, such as Resolution, Start wavenumber, End wavenumber, Pulse Rate, Pulse Width, and 
Duty Cycle. These should match how you plan to collect the spectra.  
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To collect a background, you only need to confirm that the Power level is set to 100% and choose 
a number of Backgrounds to average. We typically set this to a value of 5, as the time required is 
reasonable and the resulting background has minimal noise.  

We also recommend checking the Use Smoothing checkbox located below the Power input plot. 
This performs a lowpass filter on the power input plot to minimize high frequency noise. A value 
of 20 pt for the Intensity is the recommended value.  

After setting these parameters click the Acquire button to start the background acquisition. Once 
the background is complete (as monitored by the progress bar along the bottom of the window), 
the background can be saved and will be automatically loaded so that any subsequent spectra will 
use the new background for power normalization. 

5.5.5 IR Setup Adjustments 

After aligning, pulse tuning, focusing, and calibrating the IR laser, you may want to perform the 
following steps to optimize the laser adjustment: 

1. Run the Optimization function (at 100 µm zoom) for multiple wave numbers corresponding to 
the major absorption peaks of your sample. 

2. Run a final Pulse Tune. Adjust the Pulse Rate using the green vertical cursor if needed. 

3. In the nanoIR panel, click  Acquire to acquire a Spectrum. 

In Fast Spectra mode, Amplitude 2 is the default data channel. Click  in the nanoIR 

panel to add other channels. 

 

Figure 5-27: Fast Spectra on PMMA bead 



IR Preparation 

76 

5.5.6 Troubleshooting the AFM-IR Signal 

If there is no visible IR signal (probe oscillation) after completing Step 7 of the Fast Spectra 
Procedure, it indicates that the system is not optimized. Possible causes for this are as follows: 

• The shutter is closed on the laser housing, check the laser to make sure that any shutters are 
open. 

• The Power level is too low, try increasing the power level to as much as 40% to see if this 
shows any periodic oscillation in the NanoIR Meter view 

• The sample is not absorptive (enough) at this wavenumber. Try a different wavenumber such 
as 1730 or 1450 cm-1 which are typical absorption bands for a number of materials. It is 
helpful to have FTIR spectra of any materials which compose the sample so that you know 
which wavenumbers would have a strong IR absorption. 

• The sample is not absorptive (enough) at this location, if the sample is too thin it may not 
provide a signal or be easy to optimize the signal. Measure the thickness of the sample with 
the AFM to check that it is at least 10 nm. If not, select a thicker location for the initial 
optimization of the data collection. 

• The repetition rate of the IR source is not tuned to a contact resonance of the cantilever. This 
can be checked by performing a Laser Pulse Tune. 

• The IR light is not positioned on the AFM tip, this can happen when changing to a new tip. Use 
the optimize view to find the IR laser hot spot and position the IR light at the AFM tip location. 

• The IR Focus is set incorrectly. Typically the IR focus does not need to be changed when 
changing samples or the AFM tip unless the tip is a different style of probe. It is good practice 
to check the IR Focus value when you have a good signal and reset it to that value if you have 
any problems with the signal level. If you change the IR focus value more than a hundred pts 
you may need to perform another Optimize to re-center the IR light onto the AFM tip. 

One challenge is that the wavenumber, power and repetition rate of the IR source as well as the 
IR focus and Optimize position all need to be correct to get the optimal signal. This may require 
iteration of these settings to find out which is not correct. Knowing strong IR absorption bands for 
your sample will minimize these iterations. A method to determine the repetition rate of the laser 
without the IR source being optimized is to make use of the Thermal tune function which can be 
used to determine the contact resonant frequencies of the cantilever and then the repetition rate 
can be set manually to this value. We also recommend trying the nanoIR test sample provided 
with the system if you cannot obtain any signal on your sample. There is a technical note provided 
with the test sample which details the results you should expect from this sample. If you cannot 
obtain a signal on the test sample, please contact Bruker Corporation for assistance. 
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5.6 Acquiring IR Data 
You can use the nanoIR 3-s to acquire the following types of IR data: 

• Spectra: This is data for a single location. A sweep is performed across the selected IR 
frequency range. See Section 5.6.1, IR Spectrum Acquisition.  

• Spectra Array: Automates collection of spectra for multiple locations on the sample. See 
Section 5.6.2, Acquiring an Array of Spectra and Section 5.6.3, Acquiring a Hyperspectral Array. 

• Imaging: Maps the relative IR response across a local area of a sample, which is being 
irradiated at a selected wave number. See Section 5.6.4, PLL Mode AFM-IR Image Acquisition.  

In addition, you can gather standard AFM scan imagery. 

The following flow diagram shows the steps involved in the Resonance Enhanced AFM-IR process 
with the data collection phase highlighted. 

 

Figure 5-28: Flow Chart of Resonance Enhanced AFM-IR 

5.6.1 IR Spectrum Acquisition 
You should have already followed the instructions in Section 5.5, IR Preparation to align and focus 
the IR laser so that the signal is optimized. Verify that an appropriate IR background file is loaded 
(for more details see Section 8.3.2, IR Background Calibration).  

Follow these steps to acquire an IR spectrum for a sample location: 

1. Use the optical view and AFM imaging to find the desired sample location. Then move the 
probe to that site. 



Acquiring IR Data 

78 

2. Set the Spectra parameters in the nanoIR panel.  

o Resolution is the number of data points gathered in the spectrum.  

o Start and End specify the range of wave numbers the spectrum spans.  

o Enable multi-region allows you to select a number of regions over which a spectrum can 
be collected. In each region, a different value for the power level can be set. This is useful 
if you would like to collect data at specific absorption bands. 

3. To begin taking a nanoIR spectrum, click the Acquire button in the toolbar of the NanoIR area. 

  

4. During the spectrum collection, all the nanoIR controls are grayed out except the Cancel 
button which may be used to stop the acquisition.  

5. The spectrum data is plotted in the Spectra Graph in the Document window. 

 

6. The Document window provides controls for selecting data channels to view, examining the 
properties of each spectrum collection, customizing the color palette and how it is used in 
AFM scans, and more.  

7. You can collect spectra on multiple locations and view them together. 

 

8. To save spectrum data beyond the current session, choose File>Save from the menus.  
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5.6.2 Acquiring an Array of Spectra 

You can automate acquisition of multiple spectra as follows: 

1. Click the  Array icon in the nanoIR panel toolbar.  

2. Select the area of interest and define the separation between sites. These sites will be marked 
on the AFM image.  

3. Click Acquire. During acquisition, only this window will be active.  

4. You may stop the acquisition at any time by clicking Abort. “Complete” will be displayed at the 
end of the array acquisition. 

   

Figure 5-29: Spectra Array grid  
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5.6.3 Acquiring a Hyperspectral Array 

To acquire a hyperspectral array, follows these steps: 

1. Click the  Array icon in the nanoIR panel toolbar.  

 

Figure 5-30: Hyperspectral Array grid 

2. In the View options area, select the Channel to use for reference (Height, Phase, etc.). 

3. Click the  Array button in the toolbar to create an array in the image channel you selected.  

4. In the Size and Resolution areas, you can adjust the array location, size, and number of 
columns and rows. 

5. Check Hyperspectral box below the image. 

6. Check the Stop IR when complete box  

7. Click the  Acquire button in the toolbar. 
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5.6.4 PLL Mode AFM-IR Image Acquisition 
Infrared (IR) imaging maps the relative IR response across the local area of a sample, which is 
being irradiated at a particular wave number. The contact resonant frequency of the cantilever 
can be acquired simultaneously when using IR imaging mode. 

As the probe scans across the sample surface, the contact resonance of the probe changes. This 
can be due to stiffness differences between multiple sample components. It can also be due to 
differences in the contact area of and force interaction between the tip and sample. To collect 
meaningful data, measurements must be made when the pulse rate of the IR laser matches the 
contact resonance of the probe. This tracking of the contact resonance is accomplished through 
two different pulse Auto-Tune methods.  

You should have already followed the instructions in Section 5.5, IR Preparation to align and focus 
the IR laser so that the signal is optimized. Verify that an appropriate IR background file is loaded 
(for more details see Section 8.3.2, IR Background Calibration).  

Follow these steps to acquire IR images: 

1. Use the optical view and AFM imaging to find the desired sample location. Then move the 
probe to that site. 

2. Put a checkmark in the IR Imaging Enabled box in the nanoIR control panel.  

 

Figure 5-31:  Sample nanoIR parameters for IR imaging 

3. Enable PLL autotuning in the Laser Pulse Tune window as described in Section 5.5.2, IR Laser 
Pulse Tuning. Note that PLL mode is recommended for IR imaging but not for IR spectra 
collection. You should toggle PLL mode on and off depending on which type of data you are 
collecting. 

4. Select imaging Channels in the Microscope Window. 

  

o Set an imaging Channel to “Amplitude 2” with the Direction set to Trace. 

o If desired, set another Channel to “PLL Frequency” with the Direction set to Trace. 
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5. The Microscope window provides controls for selecting data channels to view, customizing 
the color palette and how it is used in AFM scans, and more. See Section 8.4, Microscope 
Window for more information. 

6. In the AFM Scan panel, put a checkmark in the Split Rate box.  

 

7. Set Trace Rate to 0.5 Hz. Set Retrace to 1 Hz. 

8. Click the  Scan icon in the AFM Scan panel. 

 

Figure 5-32: Resonance Enhanced AFM-IR images showing Height and Amp2 channels 

9. Disable PLL mode in the Laser Pulse Tune window when you are finished with IR Imaging. 
When PLL is enabled, it is on across all IR modes (imaging, spectra, optimize, etc.). It is only 
recommended for IR imaging. 

 

Figure 5-33: Resonance Enhanced AFM-IR Image in PLL mode at 1730 cm-1 highlights 
PMMA beads 
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5.6.5 Stepped Spectra Mode Data Collection 

Note:  Stepped Spectra mode takes significantly more time to perform a scan. It is typically 
no longer recommended. It operates by changing the wavenumber of the IR laser in 
steps and waiting for the amplitude ring-down to tail off before the next laser pulse. 
It repeats this for each point in the spectrum. See Section 9.1, Limitations of 
Conventional AFM-IR. 

If you are using Stepped Spectra mode, the following additional Spectra parameter can be set: 

• Co-averages –the number of measurements averaged to generate each data point in the 
spectra. More co-averages give a better signal to noise ratio, but increase the time to acquire 
the spectrum; a typical value is 128 pts. 

Three channels of data are collected: IR-Peak, IR-Amplitude, and Frequency. IR-Peak is the 
difference between the maximum and minimum deflection signal during the ring-down of the 
probe. IR-Amplitude and Frequency are calculated from the FFT of the deflection signal. IR-
Amplitude is the value of the largest amplitude in the FFT within the frequency window being 
searched (specified by the Freq. Center and Freq. Window parameters); Frequency is the 
frequency at which the largest amplitude occurs within the search window. 

 

Figure 5-34: A graphical description of the Stepped Spectra data channels 

If the signal to noise of a spectrum is poor, try increasing the signal strength by increasing the 
Power (or the deflection Gain if melting begins at the new Power). Make sure the signal is not too 
high by observing during the spectra acquisition that the deflection does not rail, that is the blue 
bar does not reach the top. If many of the absorption peaks of interest are at wave numbers 
where the IR laser power is low, the Power Maximizer may be useful (see Section 8.3.1, NanoIR 
Panel). 

For more information about Stepped Spectra mode, see Section 8.3.1.3, General Parameters and 
Section 9.1, Limitations of Conventional AFM-IR. 

IR-Peak 

IR-Amplitude 

Frequency 
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6 Using AFM-IR in Tapping Mode 
For more discussion of Tapping Mode operation, see Section 7.2, AFM Tapping Mode. To 
understand the theory behind Tapping Mode, see Section 9.5.4, Tapping Mode Theory. 

Setting up and running tapping mode is very similar to the contact mode procedure. This section 
covers only the differences between the two methods. A basic familiarity with contact mode and 
its operation is assumed. 

Hardware: Not all systems are equipped for Tapping AFM-IR. Please check with Bruker 
Corporation if you are unsure whether the system has the required hardware.  

 

Figure 6-1: Flow Chart of Tapping AFM-IR Imaging  

 

1. Set the AFM mode to Tapping AFM-IR Mode. 

 

2. Set up the AFM including: 

a. Install probe. Use a gold-coated tapping AFM-IR probe (model PR-EX-TnIR-A or  
PR-EX-TnIR-C).  

b. Install sample. 

c. Use Load Wizard to bring probe close to sample (approach only). 

d. Move AFM Laser onto end of probe. 

e. Align AFM Detector. 
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3. Cantilever Tune 

a. Click the   icon. 

b. If this is the 1st operation of Tapping AFM-IR, click .  

 
▪ Set Auto-Tune parameters for TnIR-A probes: 

- Search Center = 65 kHz  
- Search Range = 50 kHz 
- Mode 2 Center: Auto = checked (on) 
- Mode 2 Range = 100 kHz 
These parameters persist and do not need to be set each time. 

 

Figure 6-2: Cantilever Tune in Tapping AFM-IR mode. The 1st Mode (left) is used for 
topography and the 2nd Mode (right) is used for IR measurements. 

c. Click the Auto-Tune button.  

d. In an ideal cantilever tune: 
▪ Each mode is dominated by a single peak. 
▪ It takes less than 75% Drive Strength in the Drive Mode to achieve 9V of Amplitude. 

To try to improve either of these, adjust the position of the probe in the mount slightly. 
Shift the position of the half-washer in the mount or take the probe out and re-seat it. 
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e. Click the OK button. 

The mode frequencies and Drive Strength in the AFM Scan/Tapping AFM-IR panel are 
updated to the new values. 

 

The Pulse Rate in the nanoIR/General panel is set automatically to the difference in 
frequency between the modes. 

Pulse Rate = f 2nd Mode – f 1st Mode 

4. Engage. 

5. Collect a height image. 

o IR Imaging Enabled should be unchecked (off) in the NanoIR panel. 

 

o Verify the sample is smooth and stable, as appropriate for AFM work. 

6. Select a location. 

o It is easiest to align and optimize the IR laser with the probe on an area of the sample that 
has a known IR absorption band. 

o Use the  target icon to position the probe on a desired location in the image.  

   

Figure 6-3: The Target icon on the Microscope window and the AFM probe location on 
the AFM image (here on a PMMA bead in the test sample). 



nanoIR 3-s System User Guide 

 87 

7. Set initial nanoIR/General parameters. 

 

o Wavenumber = known IR absorption band at probe’s location 

o For the test sample, use the carbonyl peak at 1730 cm-1 on a PMMA bead. 

o If the sample is totally unknown, try a common absorption peak that the IR source covers, 
such as 1720 or 1450 cm-1. 
▪ Co-averages = 1x (disabled) 
▪ Power ~ 30% 
▪ Pulse Rate was set automatically when Cantilever Tune was completed. 

(Pulse Rate = f 2nd Mode – f 1st Mode) 

8. Increase the power to get IR signal. 

a. Add Tap-IR Amplitude to the AFM Meter. 

 

b. Click the  Start IR icon.  

c. Increase the Power gradually until Tap-IR Amplitude is at least 0.1 mV.  

If there is not 0.1 mV of signal with the power at 70%, move on to the next steps anyway. 
The optimization or pulse tune may be too far off to get signal at this point. 
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9. Optimize the IR beam position. 

a. Click the  Optimize icon.  

 

Figure 6-4: IR Laser Optimization  

b. Optimize the IR beam position at the current wavenumber.  
▪ Set the Size of the optimize scan using the slider. 

- Start with 400 µm if using a new probe. 
- Decrease to 200 µm to choose final spot position. 

▪ Click the Scan button. 
▪ Select the position of the IR spot. 

- When the scan completes, the spot position is auto-selected. 
- To choose a different location, click and drag the image. 

▪ Click Add or Update to put this position in the optimized list. 

c. Click OK to save changes and exit the Optimize window.  

10. Tune the Pulse Rate. 

a. Click the  Pulse Tune icon to open the Laser Pulse Tune window. 

 

b. Set Tune Range = 50 kHz 
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c. Click the Acquire button. 

This sweeps the pulse rate of the laser through the range defined by the Pulse Rate and 
Tune Range and plots the Tap-IR Amplitude signal.  

 

Figure 6-5: The Laser Pulse Tune window 

d. Set the Pulse Rate with the green cursor. Grab the green cursor and move it to the center 
of the peak.  

e. Click OK. The Pulse Rate in the nanoIR panel is updated. 

11. Adjust Power 

If possible, adjust the Power so Tap-IR Amplitude is between 0.5 - 10 mV. 

12. Enable IR Imaging. 

o Check the box next to IR Imaging Enabled in the NanoIR/General panel. 

 

o Set the imaging Channels in the Microscope Window.  

 

o The typical imaging Channels are:  
▪ Height 
▪ Phase 
▪ Tap-IR Amplitude 

- Capture Fit = None. 
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13. Click the  Scan icon. 

 

Figure 6-6: Tapping AFM-IR images on the test sample, PMMA and PS beads in epoxy 
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7 Standard AFM Modes 
The general procedure for using the nanoIR 3-s for Resonance-Enhanced AFM-IR mode with 
Contact Mode AFM scanning, Fast Spectra IR collection mode, and PLL (phase-locked loop) 
autotuning is described in Chapter 5, Using AFM-IR in Contact Mode. 

This chapter provides additional information about the scanning modes. 

7.1 AFM Contact Mode 
To understand the theory behind Contact Mode, see Section 9.5.3, Contact Mode Theory. 

 

Figure 7-1: Contact Mode Flow Chart 

The upper blocks of the contact mode flow chart are covered in detail in Section 5.4, AFM 
Preparation. Please refer to that section for instructions to set up the AFM and engage the probe 
onto the sample surface.  

Once the probe is engaged, set the initial scan parameters. The Setpoint is determined 
automatically during the engage process so it is already set. Reasonable starting values for the 
Scan Rate and Gains are shown in the following figure. Set the Scan Width, Height, and X/Y 
Resolution as desired. The Y Resolution (number of scan lines) directly affects the time it takes to 
collect an image. If a quick overview scan is desired, set the Y Resolution low. Then increase the Y 
Resolution to capture a high-resolution scan in the final area of interest. The X Resolution does 
not affect the image time. All the parameters are defined in Section 8.1.2, AFM Scan Panel. 
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Figure 7-2: AFM Scan panel (in contact mode, probe engaged & stationary) 

In the Microscope Window, select the Data Channels you want to collect, typically Height and 
Deflection. See Section 8.4, Microscope Window for more details. 

Click the  Scan icon to begin imaging. 

 

Figure 7-3: Contact Imaging - Microscope Window 

Generally, no further adjustment of the scan parameters is needed to achieve good imaging. 
Indications of successful imaging are: 

o The trace and retrace height contours (in the scope view below the images) match up, i.e. 
the scope traces nearly overlap, and features have nearly the same shape and slope in 
both directions.  

o There is no strong periodic noise in either the image or the scope traces. 

o The features in the height image look sharp, not smeared out to one or both sides.  

If the scan appears to need adjustment, see Section 7.1.1, Optimizing Scan Parameters. 

To center the image on a specific feature, click the  Target button on the upper toolbar of the 
Microscope Window. Then click on the desired feature in the image. The probe will stop scanning 
and move to this location. Click  Re-center on the AFM Scan panel to initiate a new scan 
centered on the new location. The X and Y Offsets update to the new coordinates.  

None of the AFM images are saved until they are captured into a document. Use the Capture 
buttons on the top toolbar of the Microscope Window to write the AFM data to a document. Click 
Capture  End of Frame to set a pending command that saves the image once the scan reaches 
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the top or bottom of its current frame. Or click Capture Now to immediately save the current 
image data. For more capture options, see Section 8.4.4, Capture. The document itself must still 
be saved (File>Save) to save the data beyond this session. 

Click the  Stop button to stop the scan at any time. The probe halts at its current x-y position 
and height feedback remains on. When the scanning session is over, click  Withdraw to pull the 
probe off the surface. 

7.1.1 Optimizing Scan Parameters for AFM Contact Mode 

A typical Scan Rate is 1 Hz. For a large scan (>30 µm) or a rough sample (>1 µm height range), the 
system may get better images with a slower Scan Rate such as 0.5 Hz. 

The Setpoint controls the force between the tip and sample. A lower Setpoint corresponds to a 
smaller force. With a very low Setpoint the probe may come off the sample surface because it 
cannot maintain stable contact with the surface. A higher Setpoint (more force) can damage a 
soft sample more easily (sample features may appear smeared) or dull the probe more quickly on 
a hard sample (small sample features cannot be resolved or take on a characteristic shape and 
size limited by the probe).  

Click  Force Reset to run an automated routine that resets the Setpoint (see Section 8.1.2, AFM 
Scan Panel for details about the routine). The Setpoint can also be reestablished manually. Set the 
Setpoint to -10 V to retract the probe (Z Position light moves to right end of bar). Note the 
Deflection value in the AFM Meter. Set the Setpoint to a slightly larger value (~0.2 V) than the 
Deflection. This should bring the probe back into contact with the sample surface (Z Position light 
moves back toward center of bar). More force (larger Setpoint) may be needed for rougher 
samples or larger/faster scans, but these methods establish a baseline Setpoint. 

As discussed in Section 9.5, AFM Theory, the Feedback Gains determine how reactive the height 
feedback is when the probe’s deflection errs from the Setpoint. Higher gains help the probe track 
larger surface features better, but such gains can make the feedback over-responsive and create 
“feedback oscillation” noise on the height data. To optimize, use the largest gains possible that do 
not induce feedback oscillation in the image data. Typical values for the I and P Gains are 10 and 
30 respectively but ideal values will depend on the type of sample and the other scan parameters. 
Higher gains may be needed for rough samples and lower gains for very smooth samples where 
reducing noise is more critical. Be cautious not to lower the gains too far, because the height data 
is only meaningful when there is enough gain to accurately track the surface. In practice, often 
only the I Gain is adjusted up or down to optimize the image and then the P Gain is set to 2 to 5 
times the I Gain. 

   

Figure 7-4: Adjusting the I Gain: (left) Too Low; (middle) Good; (right) Too High 
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7.2 AFM Tapping Mode 
For a procedure that uses Tapping Mode, see Chapter 6, Using AFM-IR in Tapping Mode. To 
understand the theory behind Tapping Mode, see Section 9.5.4, Tapping Mode Theory. 

7.2.1 Select Probe for AFM Tapping Mode 

Use a probe appropriate for tapping. We recommend that probes have a fundamental resonant 
frequency of at least 50 kHz. Bruker sells mounted tapping probes for general use. For thermal 
experiments, the shorter (200 µm long) thermal probes work in tapping mode.  

7.2.2 Align Detector for AFM Tapping Mode 

The method for detector alignment is the same in tapping and contact modes, but the default 
starting Deflection is different. After aligning the AFM laser on the cantilever, adjust the detector 
knob on the front of the head to achieve a green indicator on the Deflection light bar in the AFM 
Probe panel. The value of the deflection that corresponds to the green light is 0 V for tapping 
mode (as compared to -2 V in contact mode). 

 

Figure 7-5: The AFM Probe panel with the Deflection centered 

7.2.3 Tune Cantilever for AFM Tapping Mode 

Cantilever tune is an additional step required in the setup for tapping mode to identify the 
cantilever’s resonant frequency and set its initial amplitude. It is done after the AFM laser and 
detector are aligned and before engaging. In the AFM Scan panel select Tapping Mode from the 
drop-down list. Click the  Tune icon to open the Cantilever Tune window. (For parameter 
definitions see Section 8.1.3, Cantilever Tune Window.) 

Usually the Auto-Tune function that determines the frequency and drive is used. Occasionally, or 
if Auto-Tune fails, it may be useful to manually tune the cantilever. Both methods are discussed in 
the subsections that follow. 
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7.2.3.1 Auto-Tune 

Click the Auto-Tune button. After a couple seconds the results will display in the graph. 

 

Figure 7-6: Auto-Tune results 

Verify that the Frequency is within the expected range (200 – 400 kHz for Bruker tapping levers). 
The resonant peak should be a single peak that is reasonably symmetric.  

7.2.3.2 Manual Tune 

For Frequency, enter the nominal frequency of the cantilever’s fundamental resonance (350 kHz 
for a Bruker tapping probe). For Range, enter a value wide enough to find the resonance (~300 
kHz). Set the Drive Strength to 20%. Click Acquire to refresh the tune graph.  

 

Figure 7-7: A Cantilever Tune with a wide frequency sweep 

Resonant Peak (blue) 
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The resonant frequency should have the tallest amplitude peak in the graph and should stand out 
among all the others amplitude peaks. If there is not a clear dominant peak, increase the Drive 
Strength and increase the Range. If the resonant peak is still not clear, check that the laser is 
properly aligned on the cantilever and that the sum is a reasonable value (> 3 V for a Bruker 
tapping probe). 

Once the resonance is identified, a much narrower sweep centered about the resonant frequency 
is needed. Click and drag on the graph to draw a box just around the resonant peak. The box 
defines a new Frequency and Range. Click Acquire. 

 

Figure 7-8: Cantilever Tune with narrow sweep around the resonant frequency of probe 

The vertical green line on the graph indicates the value of the Frequency. Click on the green line 
and drag it to a frequency just to the left of the top of the peak. If Phase data will be collected 
during imaging, then click Zero Phase. Click Accept to exit the window and save the current 
settings.  

 

Figure 7-9: The AFM Meter with the Amplitude as an Input 

In the AFM Meter, set one of the inputs to Amplitude. Adjust the Drive Strength in the AFM Scan 
panel until the Amplitude is near 9 V. From this point, the probe-sample approach and engage is 
the same as contact mode. The initial Setpoint is determined by the engage routine, so it does not 
matter what the value of the Setpoint is when Engage is selected. 
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7.2.4 Acquire Image for AFM Tapping Mode 

Acquiring an image in tapping mode is nearly the same as in contact mode. The main differences 
are the Scan Rate and the Feedback parameters. Tapping mode is more sensitive to the exact 
values of these parameters and it often takes more experimentation to find the right values.  

 

Figure 7-10: The AFM Scan panel in tapping mode 

How accurately the contours of the surface are followed is called “tracking”. For a given sample at 
a particular scan size, the parameters that affect the tracking (and thus image quality) are the 
Setpoint, Scan Rate, and Gains. The ideal settings for these parameters are interdependent, i.e. 
the Setpoint value affects what Scan Rate works well, etc. Guidelines on good starting values and 
the tradeoffs for each parameter are discussed in the subsections that follow. 

  

Figure 7-11: Examples of bad tracking (left) and good tracking (right) 

7.2.4.1 Scan Rate 

The tracking is better at lower Scan Rates. The probe moves more slowly across the surface, so 
the feedback has more time to find the correct height for the probe at each location on the 
sample. The trade-off is that it takes more time to acquire an image at smaller Scan Rates. Scan 
rates are generally smaller in tapping mode compared to contact mode; 0.5 – 1 Hz are typical. At 
higher rates it is difficult to achieve good tracking.  

 

 Figure 7-12: The effect of Scan Rate on tracking 

Scan Rate = 1 Hz Scan Rate = 0.5 Hz 
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7.2.4.2 Setpoint 

The Setpoint controls the force between the tip and sample. In tapping mode, a larger Setpoint 
corresponds to less force. This is the opposite of the relationship between Setpoint and force in 
contact mode. The tracking is generally better with more force (smaller Setpoint). The trade-off is 
that a larger force has more potential to damage a soft sample or dull the probe on a hard sample. 
Use the smallest force possible (largest Setpoint) that still maintains good tracking. The initial 
Setpoint established during the engage usually corresponds to very light tapping (small forces), so 
it is typical to decrease the Setpoint by around 10% from that value. More force may be needed 
for rougher samples or different imaging conditions (larger or faster scans).  

 

Figure 7-13: The effect of Setpoint on tracking 

7.2.4.3 Gains 

Optimizing the Feedback Gains is the same as in contact mode - use the largest gains possible that 
do not induce feedback oscillation (high frequency noise) in the image data. The Gains are smaller 
in tapping mode than in contact mode. A good starting value for the I Gain is 0.4. It generally 
needs to be less than 1 to avoid feedback oscillation. The P Gain has a much broader range 
(typically less than 10), with a good starting value of 0.8.  

 
 

Figure 7-14: The effect of Gains on tracking 

Setpoint = 7.5 V Setpoint = 6 V 

I Gain = 0.2 

P Gain  = 0.5 

I Gain = 0.4 

P Gain  = 0.8 
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7.3 Force Curve Microscopy Procedure 
For details on the Force Controls Panel, see Section 8.5, Force Controls Panel. For the theory 
behind Force Curve Microscopy, see Section 9.6, Force Curve Microscopy Theory.  

1. Open the Force Controls panel via the Setup>Control Panels menu at the top of the Document 
window.  

2. Set the system up for contact mode and engage the probe on the sample.  

3. Take a height image to locate a feature of interest.  

4. Use the target tool to park the probe at the desired location.  

5. Set the Force Controls to reasonable starting values, see the following figure. 

Z-Range = 500 nm 
Rate = 1 Hz 
Resolution = 500 pt 
Limit Mode = Relative 
Deflection Delta = 0.4 V 
Channel 1 = Deflection 

 

Figure 7-15: Good initial settings for the Force Controls 

6. Acquire a force curve: 

o Single Mode 
▪ Click Acquire. Repeat to acquire more curves. 

o Continuous Mode  
▪ Click Start Continuous.  
▪ Click Capture (in Force Controls toolbar) to write the current Force Curve to a 

document. Repeat to capture more curves.  
▪ Click Stop. 

7. When finished, there are several options: 

o Use the target to move the probe to a new location to acquire more force curves. 

o Click   Scan to return to imaging. If prompted, answer Yes to turning feedback on before 
scanning. 

o Click Withdraw to pull the probe off the surface and end the session. 
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7.4 Kelvin Probe Force Microscopy (KPFM) 
Procedure 

For details on the KPFM parameters, see Section 8.6, KPFM Parameters. For the theory behind 
Kelvin Probe Force Microscopy, see Section 9.7, KPFM Theory.  

 

Figure 7-16: KPFM Operation Flow Chart 

1. Install the KPFM Module. 

o System power must be off while installing or uninstalling the module. 

2. Use the CAFM sample holder.  

 

o Connect the sample wire to the plug on the front of stage. 
▪ If this is the 1st operation of KPFM, check the voltage on the copper top of the sample 

holder with a voltmeter as you apply 1 V and 5 V via the Sample Bias in the software 
(in KPFM parameters). 
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3. Prepare the sample for KPFM. 

o Electrically connect the sample to the metal sample mount.  
▪ Silver paint is typically painted from the top surface of the sample (near the area of 

interest) to the metal mount.  

  

Figure 7-17: Examples of samples with silver paint 

▪ After paint is dry, check the electrical connection from mount to area of interest on 
the sample. 

▪ We use PELCO Colloidal Silver Liquid. 

o Remove static. 

o Any trapped/static charge on the sample surface will contribute to the measured KPFM 
signal. A Static Master (alpha source) or other static charge dissipater can be useful, 
especially for insulators. 

4. Use a KPFM probe (PtIr coated, model PR-EX-KPFM).  

o Connect the probe wire to the plug behind the head.  

o Optional: Tape down the probe wires to the z flexure on the head. This keeps the wires 
from touching the sample, which can move the probe. 

 

5. Set up for Tapping Mode. 

6. Tune the cantilever. 

o Use 9V amplitude when possible. 

o The frequency of KPFM probes is near 50 kHz.  
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7. Set interleave mode to KPFM Interleave.  

 

8. Set starting values for KPFM. 

o Tap. Freq. = checked (on) 
o Strength = 50%  
o Sample Bias = 0V 
o I Gain = 2, P Gain = 5 
o Vertical Offset = 20 nm 

9. Engage. 

10. Get a good height image. 

o Adjust tapping setpoint and gains as needed for good tracking. 
o The KPFM data  

11. Set an imaging channel to KPFM. 

 

o Direction = Interleave Retrace 

o Capture Fit = Offset (relative data) or None (raw/absolute data) 
Do not use Capture Fit set to Plane or Line Fit on KPFM data.  
For height data the tilt of the sample is generally of no interest, so it is common to remove 
the slope from the data as it saved (using Capture Fit = Plane/Line Fit). These filters are 
generally not appropriate for saving KPFM data. If needed, they can be applied afterward 
with Analysis/Process/Plane Fit or Flatten.  

 

Figure 7-18: Height (left) and KPFM (right) images of Au film on a Si wafer 
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7.4.1 Troubleshooting KPFM 

KPFM is best at measuring the CPD between 2 materials in the same image, as in the previous 
figure. The probe is the reference in KPFM, and each point in the KPFM data is a CPD 
measurement relative the probe. As long as the probe (reference) is constant then the KPFM 
between 2 points on the sample is meaningful. If the probe changes however, subsequent 
measurements will be affected. For example, the probe can pick up loose debris from the sample 
and its effective work function can be altered significantly. This creates an abrupt jump in the 
KPFM signal. The shift will appear to have a horizontal edge, in-line with the fast direction of 
scanning. Relative KPFM measurements should be correct within one piece of the image (above 
or below the change), but KPFM measures across that boundary will not be correct. If the debris 
falls back off, that creates another change. This appears as a horizontal streak in the image. 
Depending on the how rough the sample is, the shifts or streaks may not be noticeable in the 
height image but only in the KPFM image. So a clean sample is important for the best KPFM 
measurements. 

Other things that can affect the KPFM measurement are: 

• Static charge on the sample. 

• Microscopic contaminants and organic layers on the sample, such as airborne hydrocarbons. 

• Oxide layers on samples. 

• Humidity – The adsorbed water layer on surfaces in air can have a shielding effect, depending 
on the hydrophobicity of the surface and the humidity of the air. 

7.4.2 KPFM Analysis 

Two useful analysis functions for KPFM data are Profile Analysis and Histogram. In Profile Analysis, 
draw a line on the image to create a cross section of the data. To get an averaged section, 
increase the number of Perpendicular averaging pixels. Slide the two cursors to the desired points 
of measurement. 

 

Figure 7-19: Profile analysis of a KPFM image showing a CPD of 304 mV 
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In Histogram, draw exclusion boxes as needed to remove any unwanted data. Cursors can be 
added to the plot for measurement. 

 

Figure 7-20: Histogram of a full KPFM image showing the 2 main peaks 

The Mean value in the statistics can also be useful for KPFM. Use boxes to exclude the regions 
you do not want to measure. 

 

Figure 7-21: Comparing mean values of two regions 
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8 Software Interface Reference 

8.1 AFM Controls Reference 
The Controls Window contains parameters for running the instrument. The AFM controls are in 
the top portion of the window. There are 3 panels - AFM Probe, AFM Scan, and AFM Meter. The 
parameters in these panels will be defined in this section. Depending on the mode, the bottom of 
the window contains controls for nanoIR, nanoTA, Force Curves, etc. These mode control panels 
and their parameters are covered in the documentation for the corresponding mode.  

 

Figure 8-1: The Controls Window (in nanoTA mode) 

8.1.1 AFM Probe Panel 
The AFM Probe panel is primarily used when setting up the AFM before engaging.  

 

Figure 8-2: The AFM Probe panel when the probe is withdrawn 

•  Engage – brings the probe into controlled contact with the sample surface.  

(Choose Setup>Engage Settings from the menus in the Document window to further control 
the Engage process. The default settings accommodate most situations and do not generally 
need to be changed.) 

•  Withdraw – stops the scan and lifts the probe up away from the sample (by the distance 
specified by the Withdraw Height in the Setup>Engage Settings dialog, typically 50 µm). 

• Load – opens the Load Sample/Tip wizard. 

• Unload – moves the sample away from the tip by 2 mm per click. This allows you to slide the 
head out. 

• Light bars – display the probe’s Deflection and the Laser Sum of the photodetector. 

• Z-Controls – move the probe away from or closer to the sample via the Up and Down Arrows. 
The speed of the Z motor can be typed in or adjusted with the slider bar 

Keep the speed slow (< 100 µm/s) when approaching the probe near to the sample. Faster 
speeds may be used when lifting the probe away from the surface or for an initial coarse 
approach when the probe and sample are very far apart.  



AFM Controls Reference 

106 

• XY Controls - translate the sample laterally. Use the 4 Arrow buttons to position the probe 
over the desired place on the sample. The speed of the motors can be typed in or adjusted 
with the slider bar. 

Alternatively, click anywhere in the Optical View in the Microscope Window to translate that 
point on the sample under the crosshairs.  

 

Figure 8-3: The AFM Probe panel when the probe is engaged 

When the AFM is engaged, the AFM Probe panel changes slightly. 

• Light bar – displays the Z Position. At the far left of the bar, the Z Piezo is fully extended 
(probe extended toward sample); at the far right it is fully retracted. 

• Z-Step – Up and Down Arrows move the probe away from or closer to the sample in discrete 
steps using the Z motor.  

It is generally safe to step the probe up away from the sample when engaged. Stepping the probe 
down while engaged must be done with caution, as it is easy to plunge the probe into the surface. 
To step the probe down, first adjust the setpoint to retract and piezo and pull the probe off the 
sample.  

8.1.2 AFM Scan Panel 

 

Figure 8-4: The AFM Scan panel (in Tapping Mode) 

• Scan Rate – the number of image lines acquired per second. One line is both the trace and 
retrace (back and forth in the fast axis). 

• Width and Height – set the size of the image area. 

• Angle – the orientation of the image, which sets the angle of the fast direction of the scan. At 
0 degrees the fast scan direction is aligned with the x axis of the sample (perpendicular to the 
long axis of the cantilever). 

• Resolution:  

o X - the number of data points collected along each line of the image. The x pixel size is 
Width/X Resolution.  

o Y - the number of lines in the image. The y pixel size is Height/Y Resolution. 
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• Offset – the X and Y coordinates of the center of the image area (0 is the center of the scan 
range in each direction). 

• Setpoint – the value of the deflection or amplitude that the height feedback maintains during 
contact or tapping mode imaging. 

• I and P Gains – the integral and proportional gains of the height feedback.  

• Tapping Drive (Tapping Mode only) 

o Frequency – the frequency at which the tapping piezo in the probe holder is oscillated to 
drive the cantilever in tapping mode.  

o Strength – the amplitude of the drive signal to the tapping piezo as a percentage of the 
available range. 

  

Figure 8-5: The AFM Scan Toolbar 

 Scan – initiates scanning from the probe’s current position. 

 Stop – stops the probe at its current location. 

 Re-center – initiates a new scan centered on the probe’s current position. The X and Y Offsets 
update accordingly. This is generally done after the target is used to move the probe onto a 
feature of interest. 

 Frame Up – moves probe to top of image, then scanning continues downward. 

 Scan Up – sets the scan direction upward. 

 Scan Down – sets the scan direction downward. 

 Frame Down – moves probe to bottom of image, then scanning continues upward. 

 Force Reset – runs a routine that resets the Setpoint.  

First the height feedback is disabled. Then the Z Piezo lifts the probe up to pull the probe off 
the surface. The Deflection or Amplitude signal is read (contact or tapping mode) to establish 
a free-air value. Then a new Setpoint is defined based on that reading. 

The new contact Setpoint = Free-air Deflection + Contact Engage Force 

The new tapping Setpoint = (Free-air Amplitude)(Tapping Engage Force) 

Height feedback is then re-enabled using the new Setpoint. 

Choose Setup>Engage Settings from the menus in the Document window to further control 
the Engage process. Available settings include the Contact Engage Force, Tapping Engage 
Force, and Force-Reset Withdraw Height. 

 Cantilever Tune – opens the cantilever tune window, as described in the next section. 

 Drift Correction – expands the AFM Drift Correction Panel. 
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8.1.3 Cantilever Tune Window 

This window is used with AFM Tapping Mode. 

The cantilever tune is a plot of the cantilever’s amplitude as a function of its drive frequency over 
a defined range. The phase of the cantilever is also plotted. 

 

Figure 8-6: The Cantilever Tune Window 

Frequency – the frequency at which the tapping piezo in the probe holder is oscillated to drive the 
cantilever during tapping mode imaging (also shown in the AFM Scan panel). It is the center of the 
frequency window that is swept during the tune. 

Range – the width of the frequency window swept during the tune. 

Drive Strength – the amplitude of the drive signal to the tapping piezo as a percentage of the 
available range (also shown in the AFM Scan panel). 

Phase Offset – a mathematical offset applied to the phase signal. 

Zero Phase – applies whatever Phase Offset is needed to make the Phase signal zero at the 
current Frequency. 

Points – number of frequency points used in the tune. 

Duration – length of time the tune sweep takes which affects the amount of averaging at each 
frequency. 

Acquire button – takes new tune data and refreshes the graph. 

Auto-Tune button – runs a routine that automatically tunes the cantilever. This includes finding 

the resonant frequency and adjusting the drive strength. Click  to see the Auto-
Tune parameters. 

   

Figure 8-7: The standard settings for Auto-Tune 
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Target Amplitude – The drive strength is adjusted to achieve the Target Amplitude. 

Center Frequency & Frequency Range – the center and width of the frequency window that is 
swept to identify the resonant frequency. 

Peak Offset – is used to determine a frequency to the left of the actual resonant frequency. It is 
the frequency at which the amplitude is less than the peak amplitude by the Peak Offset %. 
Choosing a frequency slightly lower than resonance is a common practice in tapping mode. 

 

Figure 8-8: Peak Offset defines a frequency to the left of resonance 

8.1.4 AFM Meter 
The AFM Meter has real-time readouts of AFM related signals. Monitor up to 4 signals. The 
signals are independent from those being collected for images. Select the signals via the Data 
Inputs drop-down lists. 

 

Figure 8-9: The AFM Meter 
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8.2 s-SNOM Controls Panel 
The s-SNOM Controls panel contains parameters that control the s-SNOM portion of the 
experiment. This section describes the parameters and plots on this panel. 

 

Figure 8-10: The s-SNOM Controls panel 

8.2.1 s-SNOM Toolbar 

 

Figure 8-11: The s-SNOM Controls toolbar 

Acquire – Starts a s-SNOM spectrum. See Section 4.6, Acquiring s-SNOM Data. 

# spectrum – The number can be edited directly on the toolbar to set how many spectra to collect 
when Acquire is clicked. 

Cancel – Aborts the spectrum that is running. See Section 4.6, Acquiring s-SNOM Data. 

Array – Opens the IR Spectra Array window for automated acquisition of multiple spectra. 

Settings – Opens the Settings dialog. See Section 4.5.2, Software Parameter Setup for s-SNOM. 

Start/Stop IR – Turns the IR laser on or off. 

Align – Click to open the Center Align Laser wizard, which allows you to focus and align the visible 
alignment laser, which has the effect of focusing and aligning the invisible IR laser. See Section 
4.5.3, IR Laser Alignment for s-SNOM. 

Optimize – Opens the Optimize function. See Section 4.5.4, Signal Searching and Optimization for 
s-SNOM. 

Ref. Align – Opens the Align Interferometer dialog. See Section 4.5.5, Interferometer Alignment 
for s-SNOM. 

Interferogram – Collects a waveform showing the interference of light between the sample arm 
and reference arm. 

Capture – Save s-SNOM images and associated AFM images to a file. See Section 8.4.4, Capture. 
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8.2.2 s-SNOM Parameters 

Spectra Parameters: 

Resolution – The number of data points gathered in a spectrum. Alternatively, the number of 
wavenumbers between each point in the spectrum.  

Start/End – The beginning and end of the wavenumber range a spectrum will cover. 

Enable multi-region – Allows a spectrum to be collected over multiple non-continuous regions 
within the available wavenumber range. If this checkbox is enabled, a separate menu (accessible 
via the Settings icon) allows you to specify multiple wavenumber ranges. A different power level 
can be set for each region. Multiple ranges are useful if you want to collect data only at specific 
absorption bands. 

General Parameters: 

Wavenumber – The current wavenumber of the IR laser. 

Polarization – The polarization of the input light. The default is vertical polarization to the sample 
surface (90 degrees). 

Power – 

Source – The percentage of incoming laser power from the IR source that is directed to the 
probe-sample location. 

Interferometer – The percentage of available IR laser power directed to the reference arm of 
the interferometer. This is downstream of the attenuation from the Source power setting. 

Imaging – 

Absorption/Reflection – The s-SNOM imaging mode. “Absorption” corresponds to IR 
absorption; “Reflection” corresponds to index of refraction. See Section 9.4, s-SNOM Data 
Interpretation for details. 

Find button – An interferogram collects and the vertical cursor automatically sets an OPD 
(optical path difference) appropriate for the imaging mode. 

Lock-in – 

 Zero Phase – This button sets Φ Offset so that the phase between the lock-in input (MCT) 
and the lock-in reference (probe deflection) is zero. 

Time Constant – The time constant of the lock-in that demodulates the s-SNOM signal at the 
Tapping Drive Frequency. Usually set between 3 - 10 ms. With a longer time constant, the 
signal has more averaging but responds more slowly. 

Auto – Automatically sets the Time Constant as follows. The effective data rate of the s-SNOM 
signal matches the data rate of the AFM image. Use only when collecting s-SNOM images. 

 Time Constant = 2(Res. X)/Scan Rate 

Reference Site – the X and Y positions of the Reference Site on the sample used for spectra. The 
Set button enters the current position of the probe. 
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8.3 IR Controls Reference 

8.3.1 NanoIR Panel 
The nanoIR panel contains the parameters that control the IR portion of the experiment. This 
section gives descriptions for the parameters and plots on this panel. 

 

Figure 8-12: The nanoIR Panel 

 

Figure 8-13: The nanoIR Panel parameters 

The recommended mode is Fast Spectra for collecting Resonance Enhanced AFM-IR Spectra. 
During Fast Spectra, the IR source wavenumber continuously sweeps. A trigger is sent from the 
laser at each wavenumber specified in the spectrum to record the oscillation amplitude of the 
probe. The amplitude is measured by a lock-in amplifier at the pulse rate of the laser. 

8.3.1.1 NanoIR Toolbar 

 

Figure 8-14: The nanoIR toolbar 

Acquire – Starts a spectrum. 

# spectrum – The number can be edited directly on the toolbar to set how many spectra to collect 
when Acquire is selected. 

Cancel – Aborts the spectrum that is running. 

Array – Opens the IR Spectra Array window for automated acquisition of multiple spectra. This 
subroutine allows the user to select locations within an AFM image and define the separation 
between sites. The locations may be arbitrary points, a line array, or grid array. During the 
acquisition, only this subroutine window will be active. The user may stop the acquisition at any 
time by clicking on Abort. “Complete” will be displayed at the end of the array acquisition. 
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Figure 8-15: IR Spectra Array window  

Spectra Mode – Select the collection mode. The choices are Fast Spectra and Stepped Spectra. 
Fast Spectra mode is recommended. 

Settings – Click to open the Settings dialog. 

Start/Stop IR – Turns the IR laser on or off. 

Pulse Tune – Open the Laser Pulse Tune window. 

Align – Click to open the Center Align Laser wizard, which allows you to focus and align the visible 
alignment laser, which has the effect of focusing and aligning the invisible IR laser. 

Optimize – Opens the Optimize function (see Section 5.5.1, IR Laser Alignment). 

8.3.1.2 Spectra Parameters 

Resolution - the number of data points gathered in a spectrum or alternatively the number of 
wavenumbers between each point in the spectrum. Typically the resolution is set to 
wavenumbers using the button and a value of 2-4 cm-1 is used. 

Start/End – the beginning and end of the wavenumber range a spectrum will cover. 

Co-averages – the number of measurements averaged to generate each data point of a spectrum. 
More co-averages give better signal to noise but increase the time to acquire a spectrum. A 
typical value is 128 co-averages. 

Enable multi-region – When this checkbox is checked, the Start and End wavenumbers 
parameters will not be visible. A separate menu allows you to select a number of regions over 
which a spectrum can be collected. In each region, a different value for the power level can be set. 
This function is useful if you would like to collect data at specific absorption bands. 
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(During collection of Fast Spectra, the power level can only be adjusted at the transition between 
the QCL chips when the laser pauses to adjust the output from one chip to another. If the power 
levels are set to different values and are not precisely at the chip transitions, this can result in 
errors in the spectra). 

8.3.1.3 General Parameters 

Wavenumber – The wavenumber used for the IR Meter or when collecting an IR Image. 

Co-averages—The number of measurements averaged to generate each data point in the IR 
Meter. More co-averages give better signal to noise but increase the time to acquire the data. In 
Resonance Enhanced mode this does not impact the time to collect per pixel in the IR image, so 
this parameter is normally set to 128x. 

Power – The percentage of the available IR laser power directed to the probe-sample location. 
The laser is at full power at 100%. In the nanoIR 3-s there are discrete power levels which can be 
selected. When the sample is thinner, has low IR absorption or a low value for the coefficient of 
thermal expansion a larger value should be used. A good starting value is 3%. 

Pulse Rate – This is the repetition rate of the IR source in kHz. It should be set to match the 
contact resonance of the AFM cantilever. 

You can choose to set either the Pulse Width or the Duty Cycle; the value of the other parameter 
will be calculated based on the one you set. We recommend selecting the Duty Cycle parameter 
so that the Pulse Width parameter will be calculated.  

Pulse Width – This is the width of each laser pulse in nanoseconds. (QCL lasers only) 

Duty Cycle –Typically the Duty Cycle is set to 4% and can be limited by the specific QCL to a 
value of 5 or 10%. Increasing the Duty Cycle increases the power of each laser pulse and is 
similar in effect to changing the Power parameter. 

Freq. Center and Freq. Window – (for Fast Spectra mode) The Freq. Center and Window define 
the center frequency and width of a bandpass filter which can be used to filter the Deflection 
signal which also impacts the FFT data. This bandpass filter can be applied to the deflection data 
to minimize noise at frequencies away from cantilever resonances. The Freq. Center should be set 
to match the Pulse Rate parameter. 

Freq. Center and Freq. Window – (for Stepped Spectra mode) The Freq. Center and Window 
define the center frequency and width of the frequency range that is searched in the FFT data to 
calculate the IR-Amplitude and Frequency signals. IR-Amplitude is the largest amplitude in the FFT 
within the specified frequency range and Frequency is the frequency at which that amplitude 
peak occurs. The Freq. Center and Window also define a band pass filter which can be applied to 
the deflection data to minimize noise at frequencies away from cantilever resonances. 

Band Pass Filter – (for Fast Spectra mode) When the band-pass filter is checked, the system 
applies a filter to the deflection signal. This will also impact the FFT data which is calculated from 
the deflection data. The band pass filter is used to suppress noise from frequencies outside the 
specified range (set by the Freq. Center and Window). 

Band Pass Filter – (for Stepped Spectra mode) When the band-pass filter is checked, the system 
applies a filter to the deflection signal. This will also impact the FFT data which is calculated from 
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the deflection data. The band pass filter is used to suppress noise from frequencies outside the 
specified range (set by the Freq. Center and Window). The band pass will improve the signal to 
noise of the deflection ring-down and its FFT, improving the IR-Amplitude and IR-Peak signals 
calculated from them and is recommended for both collecting spectra and IR imaging. When 
staring with a new probe, this should initially be unchecked so that the frequencies of the various 
modes of the cantilever can be determined. Then the Freq Center can be set to the frequency of 
one of the modes. It is recommended that modes higher than the fundamental mode are used 
but the specific mode (2nd, 3rd or 4th) will depend on the specific probe and sample. 

Filter Strength – (Note: This field has been removed. The parameter is now set in a configuration 
file.) A higher Filter Strength makes the band pass filter stronger (by increasing the slope of the 
filter roll-offs). The recommended value is 50%. Too large a filter strength can create unwanted 
artifacts in the FFT, especially when the Freq. Window is narrow. 

IR Imaging Enabled – if this checkbox is unchecked the IR laser will turn off when scanning is 
started, when checked it will leave the laser on and allow IR imaging. The correct data channels 
will need to be turned on to allow IR imaging. This checkbox should be unchecked unless IR 
imaging is in process. 

8.3.1.4 NanoIR Meter 

On the right of the nanoIR panel is the nanoIR Meter. The meter has two large plots. The left plot 
(blue data) is Deflection vs. Time; the right plot (red data) is the FFT of the deflection displayed as 
Amplitude vs. Frequency. Slider bars in the bottom right of the plots scale the horizontal axes. The 
vertical axis can be auto scaled via the checkbox at the bottom left of each plot.  

 

Figure 8-16: The nanoIR Meter 

There are two vertical bar graphs to the left of these plots. The blue bar shows the IR-Peak data 
(peak-to-peak value of the deflection). The red bar shows the IR-Amplitude data (largest 
amplitude in the FFT data within the frequency range specified by the Freq. Center and Freq. 
Window parameters). Each bar graph has a cap (horizontal line) that displays the highest 
recorded value of the signal within the current session. The session can be restarted using the 
Reset button to the left of the bars.  

The vertical slider to the left of the bar graphs sets a digital Gain on the deflection signal. Typically 
this is left at the lowest position unless the SNR is poor during initial alignment of the system. If so, 
the slider bar can be increased to better see the variation during the optimization.  

Deflection FFT 



IR Controls Reference 

116 

8.3.2 IR Background Calibration Window 
An IR Background file must be loaded before any IR data can be collected. The background is the 
power of the IR laser recorded across a specified range of wave numbers. The background is used 
to remove the effect of power variation in the IR source at different wave numbers. The data 
channels IR-Amplitude and IR-Peak are divided by the background level at each wave number. It is 
recommended that a new background be acquired at least once a day to accommodate gradual 
changes in the laser power profile.  

The background can be performed at any time after the system is initialized; a probe does not 
need to be installed. Under the “Tools” menu, select “IR background calibration” and click on 
“New”. After changing any necessary parameters in the dialog box, click on “Acquire” and the 
background spectrum will be collected in the window. Click on “Save” to save the background 
data into a file (it will have the extension .irb). When saved, it will automatically load as the 
background file currently in use. When a background file is loaded its name is displayed on the 
right of the status bar along the bottom of the Document window. 

 

Figure 8-17: An example background covering the 1200 – 1800 cm-1 range  

For a procedure that uses the Background Calibration window, see Section 5.5.4, IR Background 
Calibration.  

Resolution - The Resolution specifies the number of data points or alternatively the wavenumber 
spacing between each point gathered in the range. The points per wavenumber of the 
background should be at least as great as that of the spectra it is used for.  



nanoIR 3-s System User Guide 

 117 

Start & End wavenumber - The wavenumber range is specified by the Start and End wavenumbers 
and should extend over or beyond the anticipated range of the spectra. 

Enable multi-region – This checkbox allows you to set up non-continuous regions to collect a 
spectrum or background. When this checkbox is checked, the Start and End wavenumbers 
parameters are not visible. Instead, a separate menu allows you to select a number of regions 
over which a spectrum can be collected. In each region, a different value for the power level can 
be set. This function is useful if you would like to collect data at specific absorption bands. 

Co-averages - Co-averages is the number of measurements averaged to generate each data point 
of the background. It is typically set to 128x. 

Power – this parameter allows the user to collect the background with different power levels. We 
recommend always collecting the background using a lower level of 100%. 

Backgrounds to Average – this parameter when set to a value greater than 1 will automatically 
collect multiple backgrounds and then average them together to reduce noise in the background. 
A value between 3 and 5 is optimal in terms of noise reduction versus the time required to collect 
the background. 

8.3.2.1 IR Background Menu Commands 

The following functions appear in the Tools/IR background calibration menu: 

New - The New command brings up the interface to take new background data.  

Load - The Load command brings up a dialog to select a previously saved background file to be 
used for the current experiment. The current file name is displayed on the right of the status bar 
which is along the bottom of the Document window. 

 

Figure 8-18: The red arrow points at the location showing the current background file 

Clear - The Clear command removes the current background file from use (it does not erase the 
file). The displayed status changes to “No background loaded”. 

Show - The Show command displays a graph of the currently loaded background file. 

Export to CSV - Export to CSV exports the currently loaded background data into a text file where 
each value is separated by a comma. The text file can be used to import the background data into 
other programs such as Excel.  
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8.3.3 Laser Pulse Tune Window 
The Laser Pulse Tune panel contains the parameters that control setting the Pulse Rate to match 
the contact resonance of the cantilever. A number of these parameters are duplicated in the 
NanoIR window and are initially set by the values in that window. In addition, there are 
parameters that control Autotune functions that maintain the Pulse Rate at the contact 
resonance during IR Imaging or Stepped Spectra mode. This section gives descriptions for the 
parameters on this panel. 

 

Figure 8-19: The Laser Pulse Tune window 

For a procedure that uses the Laser Pulse Tune window, see Section 5.5.2, IR Laser Pulse Tuning.  

8.3.3.1 IR Laser Parameters 

Wavenumber – The wavenumber used when collecting the Lock-in Amp 2 signal for the Laser 
Pulse Tune. 

Power – The percentage of the available IR laser power directed to the probe-sample location. 
The power can be increased if the resonance peak is not clearly resolved in the Pulse Tune. 

Pulse Rate – This parameter is the repetition rate of the IR source and is set by shifting the green 
line in the Pulse Tune.  

Tune Range – This parameter defines the range of the sweep for the Pulse Tune and is typically 
set to a large value (200-400 kHz) to initially find the contact resonance of the cantilever and then 
set to a smaller value (50 kHz) to more accurately define the Pulse Rate. 

Pulse Width/Duty Cycle – The QCL be controlled by signals from the nanoIR 3-s system which can 
set both the repetition rate of the QCL but also the laser pulse width or duty cycle. We 
recommend setting the system to control the Duty Cycle by clicking on the button after the Duty 
Cycle parameter to make it turn blue. This will allow changing of the Duty Cycle parameter and 
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force the Pulse Width parameter to match this parameter. Typically the Duty Cycle is set to 4% 
and can be limited by the specific QCL to a value of 5 or 10%. Increasing the Duty Cycle increases 
the power of each laser pulse and is very similar in effect to changing the Power parameter. 

8.3.3.2 Auto-Tune Parameters 

In order to maintain the pulse rate of the laser at the contact resonance, the system has the 
capability to automatically perform a modified Laser Pulse Tune, called a chirp. A chirp is a much 
faster frequency sweep with fewer points than a regular pulse tune. The frequency at which the 
maximum amplitude occurs during a chirp is the contact resonance. The Pulse Rate is set to this 
value (which re-centers that contact resonance within the range of the next pulse tune or chirp). 
The chirps can be continuously run to track the contact resonance of the cantilever. This function 
can be enabled when collecting spectra in the Stepped Spectra mode to prevent drift of the 
contact resonance from impacting the relative peak ratios. This is typically not required with the 
Fast Spectra because the short data acquisition times. This function is recommended when 
collecting IR images due to the larger variation of the contact resonance as the probe scans over 
regions of the sample which have different stiffness. 

Threshold – If Amplitude 2 does not exceed the Threshold value then the Pulse Rate is not 
adjusted. In Chirp mode, it is the maximum value of Amplitude 2 during the chirp. In PLL mode, it 
is the current value of Amplitude 2. The threshold prevents the Pulse Rate from being changed 
based on noise. 

Maximum/Minimum – These parameters limit the range over which the contact resonance 
tracking occurs (Chirp or PLL mode). They should be set so that the minimum is ~30 kHz below 
the contact resonance and the maximum is ~30 kHz above the contact resonance. Increasing 
these values allows the contact resonance to track larger changes in the contact resonance with 
the possibility that the Pulse Rate will shift away from the contact resonance. 

8.3.3.3 Auto-Tune PLL Mode Parameters 

PLL mode is the recommended mode for autotuning the cantilever resonance. For PLL mode 
details, see the general AFM-IR procedure, which is described in Chapter 5, Using AFM-IR in 
Contact Mode, including Section 5.5.2, IR Laser Pulse Tuning. 

Enable – When checked, the PLL (phase-locked loop) feedback is turned on. It is on across all IR 
modes (imaging, spectra, during Optimize, etc.). It is only recommended for IR imaging. 

Φ Offset – Offset to the phase signal.  

Zero button – Sets Φ Offset as needed to make the phase signal be 0 degrees. 

Setpoint – The phase setpoint of the PLL feedback, typically set to 0 degrees. 

iGain and pGain – The integral and proportional gains of the PLL feedback. 

Acquire button – takes new pulse tune data and refreshes the graph. 

OK button – exits the Laser Pulse Tune window saving the parameters, including copying the Pulse 
Rate to the NanoIR window. 

Cancel button – exits the Laser Pulse Tune window and does not retain any of the parameters. 
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8.4 Microscope Window Reference 
The Microscope window displays real-time AFM images and the optical view from the camera. Up 
to eight channels of AFM data can be acquired simultaneously. 

  

Figure 8-20: The Microscope Window 

8.4.1 Thumbnail Views 
Each of the 8 Inputs have a thumbnail view along the bottom of the window. Use the Channel 
field above the thumbnail to select the type of data to be collected for that Input. To hide the 
thumbnail views, click the dash to the left of an Input #. To resize the thumbnails, click and drag 
on the upper edge of the thumbnail panel. Note that the thumbnail views are low resolution 
(fewer pixels) so they can look different from the larger views above them and from the saved 
images in a document. 

8.4.2 Large AFM Views 
The optical image and up to three of the AFM images can be displayed as larger views in the 
upper portion of the Microscope Window.  

 

Figure 8-21: The View Display buttons 
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Use the Display buttons on the upper toolbar to select the views or to make any of them full 
screen. Each large AFM view has a Scope view below it that displays the trace and retrace data as 
it is collected. To resize the Scope views, click and drag on the upper edge of the Scope panel. 

 

Figure 8-22: The AFM View Settings 

Each large AFM view has settings that affect how the image is displayed in the Microscope 
Window as it is acquired and how the data will be saved.  

• Input – selects which AFM Input (1 – 8) is shown in the view.  

• Channel – sets the data type for the specified Input. 

• Direction – the line direction used to generate the image. Trace is the data taken from left to 
right; Retrace is the data from right to left. 

• Line fit – the filter applied to each individual line of data as it is acquired and displayed in the 
Microscope Window. 

o None - applies no filter. 

o Offset – removes the offset so each line of data is centered at zero. 

o Line – removes tilt and offset by subtracting a best-fit line from each line of data. 

• Capture fit – the filter applied to the image when it is saved via one of the capture buttons. 

o None - applies no filter. 

o Offset – shifts the whole image to make the average height zero. 

o Plane fit – applies a 1st order planefit to the whole image to remove tilt and offset.  

o Line fit – removes tilt and offset from each individual line of data in the image by 
subtracting a best-fit line from each line of data. 

• Palette – the color table used to display the height information (or other data type) in the 
image. 

• Z Range – the data range of the color palette. For example, a Z Range of 30 nm for height data 
using the BrownYellow palette assigns white to +15 nm (upper limit of color palette) and black 
to -15 nm (lower limit of color palette). 
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8.4.3 Optical View 

 

Figure 8-23: The Optical View 

To show or hide the optical view, click the Optical display button on the upper toolbar of the 

Microscope Window . To maximize the Optical view, click on the Full Screen button 
just to the right of the Optical view button. This is often helpful to see the details of the sample 
more easily. Click anywhere in the Optical view to move that point on the sample under the 
crosshairs. 

  

Figure 8-24: The Optical View buttons 

 Save – saves the optical view as a graphics file.  

 Zoom In - selects the higher magnification zoomed-in view.  

 Zoom Out - selects the lower magnification zoomed-out view.  

 Brightness - opens the Gain and Exposure controls for the camera. The Gain is a multiplier 
applied to the intensity of each pixel. The Exposure adjusts the shutter speed (integration time) of 
the camera. 

 

Figure 8-25: The focus controls on a nanoIR 3-s system 

On a nanoIR 3-s system, the focus of the camera is motorized. The single arrows move the optical 
focus up or down slowly and the double arrows move the focus more quickly.  
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8.4.4 Capture 
None of the AFM images are saved until they are captured into a document. Use the Capture 
buttons on the top toolbar to write the AFM images to a document. 

 

Figure 8-26: The Capture Buttons 

 Now – saves the current image data regardless of whether the image is complete. 

 Last Frame – saves the last full frame of image data. 

 End of Frame – saves the current image once it completes the full frame. 

 Capture End of Frame and Withdraw – saves the current image once it is completed and then 
withdraws the probe from the sample.  

 Capture Sequence… – allows the user to setup a series of images for capture. There are 
options to increment some parameters between images. 
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8.5 Force Controls Panel 
For the procedure to gather force curves, see Section 7.3, Force Curve Microscopy Procedure. For 
the theory behind Force Curve Microscopy, see Section 9.6, Force Curve Microscopy Theory.  

The Force Controls panel is opened through the Setup>Control Panels menu at the top of the 
Document window. 

 

Figure 8-27: The Force Controls panel 

Z-Limit – the Z position of the lower end of the force curve; the turn-around point. A smaller value 
shifts the whole force curve toward the sample. (Z-Limit is only set manually when Limit Mode is 
Disabled.) 

Z-Range – the Z distance the force curve spans. 

 

Figure 8-28: Illustration of the Z-Limit and Z-Range parameters 

Rate – the rate of the force curve, i.e. force curve cycles (approach and retract) per second. 

Resolution – the number of points taken in each direction. 

Restore Feedback on Stop – When the force curve is completed, the height feedback is turned 
back on. 

Limit Mode – the method used to determine the turn-around point. 

o Disabled – turn-around occurs when the Z Position reaches the Z-Limit value. 

o Absolute – turn-around occurs when the deflection reaches the “Max Deflection” value. 
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o Relative – turn-around occurs when the deflection increases by the “Deflection Delta” 
amount relative to the first point in the Force Curve. 

Force Curves are usually run in Relative Mode. 

 

Figure 8-29: Illustration of the turn-around determination of the 3 Limit Modes 

 

Figure 8-30: The Force Controls Toolbar 

 Acquire – initiates a single force curve which is written to the document automatically. 

 Start Continuous – initiates a continuous series of force curves. To save a force curve, click the 
Capture button. 

  Stop – interrupts a single force curve or ends continuous acquisition. 

  Capture – writes the next completed Force Curve to the document (in continuous mode). 

 Settings – opens the following Force Curve Settings window. Up to 4 channels of data can be 
recorded during a Force Curve.  

 

Figure 8-31: The Force Curve Settings window 
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  Array – Allows a series of Force Curves to be run using the array tool. Array points may be 
manually selected or created along a line or across a grid pattern. 

 

Figure 8-32: The Force Curve Array window 
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8.6 KPFM Parameters 
For the KPFM procedure, see Section 7.4, Kelvin Probe Force Microscopy (KPFM) Procedure. For 
the theory behind Kelvin Probe Force Microscopy, see Section 9.7, KPFM Theory.  

 

Figure 8-33: KPFM Parameters in the AFM Scan panel 

• Freq. – The frequency of VAC applied to the tip during KPFM. 

• Tap. Freq. – When selected, the frequency of VAC is automatically equal to the frequency used 
for tapping mode. 

• Strength – The amount of VAC applied to the tip during KPFM. 

• Sample Bias – Voltage that can be applied to the sample through the CAFM sample holder. 
Generally set to 0 V during KPFM operation. Non-zero sample bias is useful for testing that 
KPFM is functioning properly and for powering samples that require voltage (circuits for 
example). 

• I/P Gain – The KPFM feedback integral and proportional gains. The larger the gain, the larger 
the adjustment of VDC will be to correct a non-zero amplitude.  

o If the gains are too large, the KPFM feedback loop will ring and the KPFM signal will have 
periodic noise.  

o If the gains are too small, the KPFM signal will not get quickly to its correct value, causing 
poor lateral resolution and inaccurate data. 

• Vertical Offset – The amount the height of the cantilever is changed in the interleave line 
relative to the primary line.  

o Smaller values can improve the lateral resolution of KPFM. 

o Values that are too small can cause the tip to contact the surface during the KPFM 
measurement, especially over rougher areas of the sample or at steps. This is usually 
observed as abrupt changes in the KPFM signal. 
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9 Theory and Background 

9.1 Limitations of Conventional AFM-IR 
Traditional, non-resonant AFM-IR techniques exploit nanosecond mid-IR laser pulses. The 
absorbed mid-IR radiation is rapidly converted into heat due to molecular motion in the sample, 
which then experiences rapid thermal expansion.  

When the AFM cantilever is in contact with the sample (contact mode), it starts oscillating at its 
contact resonance frequencies due to the impulsive force exerted by the thermally expanding 
sample. However, the cantilever stops oscillating after some time due to the damping forces 
caused by the surrounding air and the contact between the AFM tip and sample. Typically the 
relaxation time for a cantilever used in a nanoIR 3-s system is ~300 - 500 μs.  

The nanoIR 3-s system uses this mode of AFM-IR scanning in its Stepped Spectra mode. The 
excitation pulses hit the sample every 1 ms. Hence, the cantilever oscillation amplitude (or 
deflection signal) decays before the next laser pulse occurs, as shown in the following figure. 

 

Figure 9-1: A diagram of the laser pulse and cantilever deflection for standard AFM-IR 
operation 

This photothermal detection technique requires high-fluence mid-IR pulses, which cause 
temperature changes typically in the few °C range, but can be up to 50 °C or higher, to produce a 
detectable deflection signal. These requirements result in larger optical sources along with 
potential thermal damage to the sample, especially for thinner samples.  

9.2 Resonance Enhancement AFM-IR 
AFM-IR with Resonance Enhancement (Fast Spectra mode) avoids the above limitations by using 
higher repetition rate laser pulsing, where the repetition rate can be tuned over a broad range 
and offers superior signal to noise with minimal thermal damage. 

Cantilever oscillation can be described as a damped harmonic oscillator. The energy stored in a 
damped oscillator decays in each oscillation cycle as shown above. The ratio of the energy stored 
and energy dissipated per cycle is defined as the quality factor (Q) of an oscillator. If the energy 
losses for each oscillation period can be restored somehow, the cantilever will oscillate forever  
(Q ~ ∞). Since damping forces cannot be eliminated in a real system, the only way to restore the 
losses is to apply a driving force for each oscillation period (forced-damped harmonic oscillator). 
Resonance enhancement is achieved if the driving force is periodic and in resonance with the 
cantilever. In AFM-IR, the driving force is the optical pulse of the IR source which causes sample 
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heating and expansion due to absorption. The resonance condition is achieved by tuning the laser 
repetition rate to the cantilever’s resonant frequency.  

 

Figure 9-2: Laser pulses and cantilever deflection for resonance enhanced AFM-IR 
operation 

The effect of resonance enhancement on the oscillation of the cantilever is described by: 

∆𝑧𝑟 ≈ ∆𝑧 × 𝑄 

where Δzr is the deflection signal (oscillation amplitude) at resonance, Δz is the deflection induced 
by a single light pulse and Q is the quality factor. Therefore, by taking advantage of the high Q we 
can use low fluence optical pulses to achieve significantly higher signal to noise with minimum 
thermal damage. 

As mentioned above, the repetition rate of the IR source needs to be matched to the cantilever 
oscillation frequency. When the AFM probe is brought down into contact with the sample surface, 
the vertical position of the tip-end of the cantilever is fixed (the tip is pinned on the sample 
surface) causing the probe’s resonant frequency to shift significantly higher than its free 
resonance in air. This higher frequency is called the contact resonance and will depend on a 
number of factors including the original free resonance of the cantilever, the contact area 
between the tip and sample, and the stiffness of the sample. The contact resonance needs to be 
determined frequently as the tip scans across the sample surface or even if the probe is kept at a 
fixed location. In nanoIR 3-s systems equipped with a high repetition rate IR source, the laser is 
tuned to the contact resonance by sweeping its pulse rate and monitoring the oscillation 
amplitude of the AFM cantilever. 

The IR sources used for the Resonance Enhanced mode are the Quantum Cascade Laser (QCL) 
and a high repetition rate OPO. A QCL is a semiconductor laser in which the repetition rate and 
duty cycle can be controlled by electrical pulses output from the nanoIR 3-s system. Each QCL 
chip typically covers a narrow range of the mid-IR spectrum (averaging 200 cm-1). To cover a 
broad range, multiple QCL chips (up to four) can be combined into a single IR source. This can 
allow coverage over a range from ~800 to 1800 cm-1 within a single source.  

In addition, QCLs have been developed to cover other portions of the mid-IR range if specific 
absorption bands outside of this range are of interest. Also, the high repetition rate OPO is 
available which can cover the shorter wavelength range of the mid-IR allowing measurements of 
the CH, OH and NH stretch absorption bands. Contact Bruker Corporation if a particular 
wavelength range outside the default range is of interest. 
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9.3 s-SNOM Theory 
In a s-SNOM experiment, the incident light is focused onto the apex of the AFM tip, and the 
scattered light carrying the optical properties of the sample is collected. The high spatial 
resolution of s-SNOM is provided by the localized light-matter interaction under the AFM tip. By 
raster scanning across the sample while detecting the scattered light, the optical response of the 
sample is mapped with nanometer spatial resolution. 

A typical s-SNOM experiment setup is illustrated in Figure 9-3. It consists of two key parts, a 
Michelson interferometer and an AFM at one arm of the interferometer (refer to as sample arm). 
In the sample arm of the Michelson interferometer, a focal optics (typically a parabolic mirror) 
focuses the incoming light to the tip and collects the scattered light; the other arm, called the 
reference arm, consists of a reflective mirror to coherently amplify the weak scattered light from 
the tip and for interferometric detection to resolve the optical phase. Due to the similarity in the 
optical detection scheme, s-SNOM can be seen as a natural extension of Fourier-transform 
infrared spectroscopy (FTIR). 

 

Figure 9-3: s-SNOM schematics showing signals 

Incoming light splits into two paths after the beamsplitter (BS). The path passing through the BS is 
focused on the tip and sample by a parabolic mirror. The back-scattered light is collected by the 
same parabolic mirror and redirected to the MCT detector. The other path reflected from the BS 
serves as a reference beam for interferometric detection to retrieve the phase of the tip-
scattered light. 

The tip-scattered light contains both the local near-field signal  and the unspecific far-field 
background from the tip and the sample . In order to suppress the background, the scattered 
light is modulated by the AFM tip oscillation at its mechanical resonance frequency . Despite 
the modulation, the coherent nature of the incident laser light makes the photons emitted from 
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the local tip-sample region interfere with the far-field background. Thus, the light on the detector 
has a time-averaged intensity defined as follows:  

  (Eq. 9.1) 

Where the term  is due to the multiplicative far-field background. The  
and  terms are the phase of the near-field signal and background, respectively. As the far-field 
background  is randomly scattered from the whole illuminated area, the phase  is generally 
uncontrolled.  

To fully characterize the near-field signal and suppress the multiplicative far-field background, 
interferometric detection with a known reference beam can be used to determine both the 
amplitude and phase of the near-field signal. By adding the reference term , the intensity at 

the detector becomes Eq. 9.2, where  is the phase of the reference arm: 

  (Eq. 9.2) 

After demodulating the detected signal at higher harmonics of the AFM tip oscillation frequency 
(i.e., and higher), only the terms being modulated at  or higher harmonics remain. The 

following terms in Eq. 9.2 contain  :  and  .  

Typically, the second harmonic signal after demodulation, I2, is chosen to represent the near-field 
signal, with I2 being as follows: 

   (Eq. 9.3) 

The first term  is due to the multiplicative far-field background. 

The near-field amplitude | | and phase  can be obtained from the second term 

 by controlling the reference phase .  

Various phase modulation methods have been developed to suppress the background term and 
to extract the amplitude and phase.  

In Eq. 9.3, I2 forms a sinusoidal function (interferogram) with respect to the reference phase .  

Figure 9-4a shows two such interferograms taken on locations of two different materials by 
linearly moving the reference mirror (i.e., linearly changing the reference phase). The blue curve 
is an interferogram taken on a material of interest at position A, while the red curve is taken at a 
gold substrate at position B as a reference. 

Although being constant, in general the absolute amplitude | | and phase  of the reference 
beam in Eq. 9.3 is undetermined. As a result, to determine the scattered light from a point of 
interest (A), a reference interferogram from a known material (B) needs to be collected and 
subtracted from the interferogram A. 
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The amplitude ratio of the interferograms A and B represents the relative amplitude of the 
scattered light | |, while the phase difference of interferograms A and B represents the relative 
phase of the scattered light .  

 

Figure 9-4: Interferograms corresponding to near-field phase images 

(a) Interferometric detected near-field signal forms a sinusoidal wave as the reference 
mirror linearly translated in the Michelson interferometer in Figure 9-3. 

(b)  Resulting spectrum of amplitude and phase across an amide I band resonance of 
the organic defect sample. 

(c)  Two locations on and off the feature of interest correspond to curves A and B in (a). 

(d)  Near-field phase image for the organic defect on gold substrate on resonance at 
1659 cm-1 (c) and off resonance at 1605 cm-1. 

The amplitude and phase delay of the interferogram carries spectroscopic information of the local 
sample material and changes with the local material. To extract spectroscopic information, the 
signal on a point of interest needs to be normalized to a reference signal obtained on a known 
substrate with flat spectroscopic response (typically gold or silicon). 

The amplitude ratio and the phase difference of the two sinusoidal waves in Figure 9-4a contain 
the spectroscopic information of the sample, and vary with wavelength. As the wavelength 
changes, the amplitude ratio and the phase difference vary accordingly. For a single wavelength, 
the amplitude and phase of a sample at the specific wavelength can be extracted from 
interferograms as mentioned above. 

By stepping the laser wavelength across a wide spectral range, e.g. with a tunable continuous-
wave (CW) laser, a spectrum of both amplitude and phase can be obtained. 
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Figure 9-4b shows the amplitude (red) and phase (blue) spectrum of an organic defect on gold 
film with its resonance at around 1660 cm-1. The amplitude and phase spectrum can thus be used 

as approximation to complex dielectric function of . 

The amplitude spectrum shows a dispersive line shape which corresponds to the refractive index 
(n) or the real part of the dielectric function ( ). 

The phase spectrum shows an absorptive line shape resembling the conventional FTIR spectrum. 
It corresponds to the extinction coefficient (k) or the imaginary part of the dielectric function ( ). 

This approximation is typically valid for weak resonances, such as molecular vibrational resonance. 
However it can fail for collective resonances such as surface phonon or surface plasmon polariton 
resonances. Interpretation of the s-SNOM signal is discussed in the next section. 

9.4 s-SNOM Data Interpretation 
s-SNOM collects data from a complex optical signal, with the amplitude corresponding to the real 
part of dielectric function , while the phase corresponds to the imaginary part of dielectric 
function . This rich optical information sometimes makes data interpretation difficult without 
understanding the physics behind it. 

This section introduces the physics by stepping through an example that measures the dielectric 
function of a common organic material—Poly(methyl methacrylate) (PMMA). 

To study the relation between the near-field spectra and the dielectric function of the sample 
material, we start with a model material with a single Lorentzian resonance. The dielectric 
function of the sample material can be modelled as a harmonic oscillator with resonance 
frequency , line width , and coupling strength A, with: 

      (Eq. 9.4) 

Figure 9-5 shows the dielectric function of PMMA across its carbonyl resonance at around 
1729 cm-1. Both the real (black) and imaginary (blue) parts of the dielectric function are shown. 
The ellipsometry measurements are shown as thick lines; the thin lines show Lorentzian oscillator 
fits to the experimental dielectric functions with a resulting coupling coefficient. 

 

Figure 9-5: Dielectric function of PMMA  
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To understand the correspondence of s-SNOM data to the sample dielectric function, we 
compare experimental s-SNOM spectra to PMMA dielectric function. 

Figure 9-6 (a) shows the topography of a sample region with a PMMA bead together with other 
topographic features. The PMMA bead can be clearly identified with a big phase shift relative to 
Figure 9-6 (b) the epoxy matrix from the s-SNOM phase image taken on resonance at 1729 cm-1.  

 

Figure 9-6: Comparison of topography image and s-SNOM phase image 

Figure 9-7 (a) shows the s-SNOM spectrum on PMMA, with phase in blue and amplitude in red. 
The s-SNOM phase (blue) shows an absorptive-like profile, with peak of 1.2 radian (60 deg). The s-
SNOM amplitude (red), as ratio of scattering intensity of PMMA to the surrounding epoxy, follows 
a dispersive line shape. The amplitude and phase can also be transformed to real and imaginary 
parts as in a coordinate transformation. 

Figure 9-7 (b) shows the normalized s-SNOM real and imaginary spectra in red and blue dots, with 
a solid line for ellipsometry data. After proper scaling, Figure 9-7 (b) shows that the s-SNOM 
spectrum can overlap very well with the bulk dielectric function of PMMA.  

Thus we see that s-SNOM spectra can be retrieved to obtain the underlying sample optical 
dielectric function. 

 

Figure 9-7: PMMA spectrum plotted in amplitude and phase or real and imaginary part 
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9.5 AFM Theory 
An Atomic Force Microscope (AFM) makes very fine-scale images of surfaces. A flexible probe 
with a sharp tip is scanned back and forth across the sample’s surface. The mechanical interaction 
of the probe with the surface is used to generate a 3D map of the sample surface. Two methods 
of height imaging on the AFM, contact and tapping, are discussed in the following sections. Each 
method generates a height value (z) of the sample at each x and y position.  

 

Figure 9-8: AFM probe scanning the sample 

9.5.1 Detection Scheme  
Our AFMs sense the mechanical interaction of the probe with the sample surface using an optical 
lever detection method. The probe is a long thin Si cantilever with a sharp tip oriented toward the 
sample surface. The cantilever is flexible and bends upward when gently pressed onto the sample. 
The bending of the cantilever is measured by a photodetector. A laser diode shines a beam of red 
light onto the back of the reflective cantilever. The light bounces off the back of the cantilever 
and up onto the detector.  

 

Figure 9-9: Optical lever detection scheme of the AFM  
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The angle of the cantilever determines the angle of the reflected light beam and thus the vertical 
position of the laser spot on the photodetector. The cantilever and detector are arranged so that 
a very small change in the cantilever’s angle moves the spot significantly on the photodetector. 
Imagine standing in the middle of a room and shining a laser pointer down onto a mirror that is 
oriented to reflect the laser spot onto the middle of the wall. By moving one end of the mirror a 
few centimeters to change its angle, the laser spot could be translated up and down the entire 
height of the wall. This is the same optical lever scheme employed in the AFM. When the tip end 
of the cantilever moves a tiny amount (nanometers) changing the angle of the cantilever, the 
laser spot moves on the photodetector a much larger distance (millimeters). However, if the 
entire cantilever moves up or down, its angle does not change. Then there is no geometric 
amplification, meaning a 1:1 ratio of tip movement to spot movement on the detector. So optical 
lever detection is very sensitive to angle changes of the cantilever, but insensitive to its parallel 
translation. 

9.5.2 Photodetector  
The photodetector generates a voltage proportional to the amount of light hitting it. The 
photodetector is split vertically, generating separate voltages for the top and bottom halves, Vtop 
and Vbottom. The Deflection signal measures the vertical position of the spot by comparing the 
signals from the top and bottom halves of the detector. 

Deflection = Vtop - Vbottom       (Eq. 9.5) 

 

Figure 9-10: Relationship of cantilever angle and Deflection signal 
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If the spot is perfectly centered the Deflection is zero. This can correspond to any angle of the 
cantilever and depends on how the Deflection is adjusted during setup before the probe is 
engaged onto the surface. It is the relative change in Deflection that is most meaningful for 
creating height images. As the cantilever bends upward, the spot moves upward on the detector 
and the Deflection becomes more positive. As the cantilever bends downward, the Deflection 
becomes more negative. 

The Sum signal measures the total amount of light on the detector. When the spot is fully 
contained on the detector the Sum will be at a maximum.  

Sum = Vtop + Vbottom        (Eq. 9.6) 

 

Figure 9-11: Relationship of spot position and Sum signal 

The detector is divided into quadrants. Comparing the left and right sides of the detector gives a 
measure of the twist of the cantilever, called Lateral Deflection. 

Lateral Deflection = Vleft – Vright      (Eq. 9.7) 

 

Figure 9-12: Relationship of spot position and Lateral Deflection signal 

9.5.3 Contact Mode Theory  
When the probe contacts the surface the cantilever bends upward. The laser spot moves upward 
on the photodetector and the Deflection signal increases. The probe is pressed into the surface 
just enough so that a preset increase in Deflection is achieved. The probe then scans quickly back 
and forth in X as it slowly moves in Y to cover the area defined by the scan parameters. As the 
probe moves over the sample the cantilever will bend in response to the topography of the 
surface. When moving over a tall feature, the tip is pushed up and the cantilever bends upward. 
Over a low feature, the tip moves down, and the cantilever relaxes downward.  

If no feedback were used, the cantilever’s height (Z position) would be held constant. The 
cantilever’s angle and thus the Deflection would continually change as the probe scanned over 
the sample. This is depicted in the upper portion of the following figure. Though it is technically 
possible to generate a sample’s height profile from the Deflection signal when feedback is off, it is 
rarely done due to its many limitations (including small Z range, variable tip/sample force, and 
unique Z calibration for each probe and each laser alignment). 
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Figure 9-13: Contact mode with feedback off (top) and on (bottom) 

Instead, a feedback loop is employed that adjusts the height of the cantilever to keep the 
Deflection signal at a constant value (the Setpoint). To keep the cantilever at the same angle, a 
constant separation between the back end of the lever and the tip’s point of contact with the 
surface must be maintained. This is achieved when the probe is moved up and down to follow the 
exact contour of the surface, as shown in the bottom portion of the previous figure. The Z 
position of the probe is recorded as the height data for the sample. A larger Setpoint corresponds 
to more force between the probe and sample. 

The feedback loop works by comparing the actual Deflection with the Setpoint and adjusting Z to 
minimize the difference between those values. When a tall feature on the sample is first 
encountered the tip moves up slightly causing the Deflection to increase. That small error 
(difference between the Deflection and Setpoint) tells the probe to move up away from the 
sample. How much the probe’s Z position changes in response to a given amount of error is 
determined by the gains of the feedback loop. The larger the gains, the more the Z position will 
change. There are two gains, integral (I Gain) and proportional (P Gain). 

∆Z ∝ IGain∫(error)dt + PGain*error      (Eq. 9.8) 

The gains need to be large enough that the probe is moved quickly to the correct height so but 
not so large that feedback oscillation occurs (i.e. the probe overshoots the correct position, then 
over-corrects and undershoots it, etc.) causing noise in the height data.  

For information about operating in Contact Mode, see Section 7.1, AFM Contact Mode. 
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9.5.4 Tapping Mode Theory 

For a procedure that uses Tapping Mode, see Chapter 6, Using AFM-IR in Tapping Mode. For 
further discussion of Tapping Mode operation, see Section 6, Using AFM-IR in Tapping Mode.  

Tapping mode is another method for height imaging on the AFM. Tapping generally has smaller 
forces between the tip and sample compared to contact mode. In tapping, the probe does not 
drag along the surface so there is little frictional force. Tapping is often used on soft samples that 
are easily damaged or very hard or rough samples that quickly dull the probe in contact mode. 
Tapping is very similar to contact mode except the probe is mechanically oscillated creating an AC 
Deflection signal. The amplitude of the probe is used to generate the height value (z) of the 
sample at each x and y position. 

The cantilever’s oscillation is driven by a small piezo under the probe mount that is shaken at the 
resonant frequency of the cantilever. The same detection scheme is used where a change in the 
angle of the probe shifts the reflected laser spot’s position on the photodetector. As the 
cantilever swings up and down, the spot moves up and down on the detector creating an AC 
Deflection signal characterized by its Amplitude. The larger the cantilever’s oscillation, the larger 
the Amplitude signal.  

 

Figure 9-14: Relationship of cantilever motion and Amplitude signal 

Engaging the probe brings it close enough to the sample so that the tip contacts the surface 
during the bottom part of the cantilever’s swing. Once the tip is “tapping” on the surface, the 
Amplitude is determined by the relative height between the back end of the lever and the point 
of contact with the sample.  
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When the cantilever is closer to the surface, more of its swing is blocked and the Amplitude is 
smaller. When the cantilever is further from the surface, less of its swing is cut off and the 
Amplitude is larger. As the probe scans over the sample, the Amplitude changes in response to 
the topography of the surface. When moving over a tall feature the Amplitude decreases; over a 
low feature the Amplitude increases.  

 

Figure 9-15: Tapping mode with feedback off (top) and on (bottom) 

If no feedback were used, the cantilever’s height would be held constant and the Amplitude 
would continually change as the probe scanned over the sample. But just like contact mode, a 
feedback loop adjusts the height of the cantilever to keep the Setpoint constant. The difference is 
that in tapping mode the Setpoint is Amplitude instead of Deflection. In tapping mode, a smaller 
Setpoint corresponds to more force between the tip and sample (which is the opposite of the 
relationship in contact mode). 
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9.6 Force Curve Microscopy Theory 
For the procedure to gather force curves, see Section 7.3, Force Curve Microscopy Procedure. For 
details on the Force Controls Panel, see Section 8.5, Force Controls Panel.  

In a force curve, the AFM probe is moved down in Z to touch the sample and then moved back up 
to pull off the sample. During the force curve the probe’s deflection and other signals may be 
monitored.  

 

Figure 9-16: The anatomy of a force curve 

In Analysis Studio, a force curve is plotted so the probe is closer to the sample on the left of the 
plot (smaller Z Position). A force curve starts with the probe above the sample surface (A). The 
height feedback is off. The probe lowers toward the sample (“approach”). Attractive non-contact 
forces (Van der Waals, electrostatic, etc.), as well as the capillary force of any surface water layer 
encountered pull the tip into sudden contact with the sample (B). As the probe moves farther 
down, the force on the probe from the sample becomes repulsive; the cantilever bends upward 
and its deflection increases (C). When the probe reaches the turn-around point, its direction 
reverses, and it moves away from the sample (“retract”). The tip stays in contact with the sample 
past the point where it initially made contact. Adhesive forces hold the tip on the sample; the 
cantilever buckles and its deflection decreases (D). When the adhesive forces are overcome by 
the spring force of the cantilever, the tip pops off the sample surface (E).  
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9.7 KPFM Theory 
For the KPFM procedure, see Section 7.4, Kelvin Probe Force Microscopy (KPFM) Procedure. For 
details on the KPFM parameters, see Section 8.6, KPFM Parameters.  

Kelvin Probe Force Microscopy (KPFM), also known as surface potential microscopy, is a non-
contact AFM mode that measures the local contact potential difference (CPD) between a 
conductive AFM tip and the sample surface.  

9.7.1 Contact Potential Difference Measurement 

The CPD is the difference in the work functions of the tip and sample, so a KPFM image maps the 
relative work function of the sample. The work function relates to many surface phenomena, 
including catalytic activity, reconstruction of surfaces, doping and band-bending of 
semiconductors, charge trapping in dielectrics, and corrosion. The map of the work function 
produced by KPFM gives information about the composition and electronic state of the local 
structures on the surface of a solid. 

 

Figure 9-17: Electronic energy levels of the sample and AFM tip. (a) Electrically isolated 
tip and sample (b) Sample and tip are in electrical contact, (c) External bias (VDC) is 
applied to balance CPD. φs and φt are the work functions of sample and tip. EVAC is 
the vacuum energy level. Es and Et are the Fermi levels of the sample and AFM tip 
respectively. 

The AFM cantilever is a reference electrode that forms a capacitor with the surface, over which it 
is scanned laterally at a constant separation. The cantilever is not piezo-electrically driven at its 
resonance frequency ω0 as in normal tapping mode AFM; instead, an AC voltage is applied at this 
frequency (ω = ω0). When there is a net DC potential difference between the tip and the surface 
(VDC ≠ VCPD), the AC+DC voltage creates an electrostatic force that causes the cantilever to vibrate 
at frequency ω. If there is no net DC difference (VDC = VCPD), then the electrostatic force 
component at ω will be zero and the oscillation amplitude at this this frequency also vanishes. 
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This can be seen in more detail by examining the electrostatic forces (F) between the tip and the 
sample surface that can be expressed as  

𝐹(𝑧) =  −
1

2
∆𝑉2 𝑑𝐶(𝑧)

𝑑𝑧
                                                                                  (Eq. 9.9) 

where the differential term indicates the gradient of the capacitance between tip and the sample 

normal to the sample surface and V is the voltage difference between VCPD and the voltage 
applied to the tip (Vtip). When both AC and DC voltage is applied to the AFM tip, 

∆𝑉 = 𝑉𝑡𝑖𝑝 − 𝑉𝐶𝑃𝐷 = 𝑉𝐷𝐶 + 𝑉𝐴𝐶𝑠𝑖𝑛(𝜔𝑡) − 𝑉𝐶𝑃𝐷                                          (Eq. 9.10) 

Substituting V into equation 4.1 yields the following terms: 

𝐹𝐷𝐶 = −
𝑑𝐶(𝑧)

𝑑𝑧
[

1

2
(𝑉𝐷𝐶 − 𝑉𝐶𝑃𝐷)2]                                                      (Eq. 9.11) 

𝐹𝜔 = −
𝑑𝐶(𝑧)

𝑑𝑧
(𝑉𝐷𝐶 − 𝑉𝐶𝑃𝐷)𝑉𝐴𝐶𝑠𝑖𝑛(𝜔𝑡)                                              (Eq. 9.12) 

𝐹2𝜔 = −
𝑑𝐶(𝑧)

𝑑𝑧

1

4
𝑉𝐴𝐶

2 [cos(2𝜔𝑡) − 1]                                                   (Eq. 9.13) 

Equation 4.4 represents the working principle of KPFM measurements. Fω is the oscillating force 
experienced by the AFM probe due to its interaction with the sample surface by the applied AC 
(at frequency ω) and DC voltages. When applied DC bias (VDC) is equal to the contact potential 
difference between the sample and the probe (VCPD), the exerted force at ω will vanish and so will 
the oscillation amplitude. So, we can compose a map of the relative work function of the sample 
by adjusting VDC at every measurement point to nullify the amplitude at ω. This is the working 
principle of KPFM.  

 

Figure 9-18: KPFM Feedback 

The amplitude (at ω) scales with the magnitude of the difference between VDC and VCPD but does 
not indicate which voltage is larger. The KPFM feedback needs to adjust VDC to match VCPD, so the 
amplitude alone is not enough information. However, the phase between the cantilever’s 
oscillation (at ω) and VAC changes sign depending on whether VDC is larger or smaller than VCPD, so 
the sign of the phase provides polarity for the KPFM feedback loop. 
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9.7.2 KPFM Interleave Mode 

KPFM is a non-contact technique; the tip should not touch the surface during the KPFM 
measurement. This is achieved using interleave mode scanning where the tip scans each line of 
the surface twice.  

 

Figure 9-19: Interleave Mode Scanning 

In the primary line, the tip scans back and forth (trace and retrace) in normal tapping mode to 
measure the height of the sample. Then the interleave line scans back and forth over the same 
line of the sample surface. There is no height feedback on during interleave and the tapping piezo, 
that shakes the cantilever for tapping mode, is disconnected. The tip follows the height contour 
measured during the primary line with the addition of an adjustable vertical offset. During the 
interleave line, the electrical drive VAC is applied to the tip. The KPFM feedback is enabled which 
adds whatever VDC is needed to the tip to zero out any amplitude from the electrical forces at ω. 

 

Figure 9-20: KPFM Interleave Mode 



nanoIR 3-s System User Guide 

 145 

10 Environmental Chamber and RH-200  
This chapter describes the operation of the Environmental Chamber as well as the humidity 
generator known as the L&C Sciences RH-200.  

 

Figure 10-1: Flow Chart of RH Controlled Nitrogen sent from the RH-200 to the 
Environmental Chamber 

10.1 Limitations and Capabilities 
The Environmental Chamber, when paired with the heating and cooling sample mount has been 
designed to allow for total control of sample temperature as well as environmental conditions 
locally with respect to the sample and AFM cantilever. The temperature-controlled sample mount 
is a thermoelectric element, voltage controlled, which allows the user to cool or heat the sample 
from -20 °C to 80 °C respectively. The humidity generator, when paired with the environmental 
chamber, permits the control of relative humidity with respect to the sample and cantilever 
ranging from 20% RH to 80% RH. 

To limit dead volume near the sample, the environmental chamber has been made rather 
compact. It is due to this that the sample size as well as total sample range is reduced and limited. 
The sample range in X and Y is ±2mm from the center of the environmental chamber. The sample 
size for heating and cooling application with the environmental chamber is now limited to a 
12mm diameter sample mount.  

Due to geometric constraints, the sample height in Z must also be taken into account during 
sample prep. The sample mount, substrate, and sample must be less than 3mm in height. If the 
total height is much larger than this, the sample will interfere with the environmental chamber 
when the head is slid into position.  

Bruker currently supports the environmental chamber and temperature-controlled sample mount 
on any variation of the nanoIR 3 as well as the nanoIR 3-s. 
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10.2 General Part Description 
The Humidity and Temperature Control Assembly comprises the following: 

• Environmental Chamber – An enclosure that magnetically secures to the AFM head. The 
chamber contains an IR window to allow for the use of all nanoIR 3-s techniques. Air is flowed 
through a silicone tube to the environmental chamber from the humidity generator. The AFM 
head is connected to the Environmental Interconnect through one signal wire for the RH 
sensor and one air hose.  

• Environmental Chamber Sample Mount – If only interested in controlling the Relative 
Humidity, a non-temperature controlling sample mount can be used. This sample mount 
allows for the adjustment of relative humidity within the environmental chamber without the 
extra wires associated with the temperature-controlled sample mount.  

• Environmental Interconnect – This junction box routes all necessary cables and hoses from 
the outside to the inside of the system.  

• Temperature Controller – This unit supplies a feedback controlled voltage to the 
Temperature-Controlled Sample Mount. The real-time sample temperature is measured with 
a thermocouple and displayed on the digital screen. The controller feedback is controlled by 
an adjustable gain PID controller with a user defined setpoint.  

• Temperature-Controlled Sample Mount – Also known as the heater/cooler sample mount 
allows the sample temperature to be controlled on a range from -20 °C to 80 °C in ideal lab 
conditions. The temperature-controlled sample mount is connected to the Environmental 
Interconnect through one wire and two water hoses. The wire provides signal and power to 
control the stage feedback. The water hoses provide cooling for the thermoelectric element.  

• Cole Parmer Peristaltic Pump – This pump supplies cooled water from the ice bucket to the 
Temperature-Controlled Sample Mount. When operating the feedback loop for the 
Temperature-Controlled Sample Mount, the peristaltic pump must be operating. The pump is 
bidirectional. To maintain AFM performance, you should turn on the pump in the direction 
that flows water through the large white pulse dampener first.  

• RH-200 – This device controls the humidity of the nitrogen delivered to the Environmental 
Chamber through a feedback control of two mass flow controllers. 
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10.3 General Handling and Installation 
The Environmental Chamber contains one wire assembly and one air hose that are essential for 
communication and the travel of humid air from the generator to the sample. Although strain 
relief has been built into the cable, there is a need to take caution when installing and removing 
the environmental chamber. When handling the environmental chamber, be sure to hold as 
shown.  

 

Figure 10-2: Safe ways to handle the Environmental chamber. When handling, be 
careful not to touch the IR window. 

10.3.1 Order of Operations for Connecting 

1. Load AFM Probe 

2. Place the sample on the sample mount of choice. Then place the sample mount on the Scan 
Stage. If using the temperature-controlled sample mount, connect the wire and water hoses 
to the interconnect. 

3. Install the Environmental Chamber. 

4. Slide the head into position and proceed with standard AFM operation. 

 

Figure 10-3: Proper connection for the Env. Chamber with the Env. Interconnect 
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10.4 Setting the RH-200 Software 
The RH-200 software runs stand-alone from the Analysis Studio Software. See the following steps 
for preparing and running an experiment.  

1. Double-Click the  icon to open the program. 

 

2. A screen will open with readouts for the mass flow controllers, feedback variables, and the 
home screen. To begin setup, click the experiment button and populate required fields. 

 

3. Adjust the desired RH, Humidifier Temperature, and Time to fit the experiment at hand. Once 
Adjusted, click Add to include as many steps as desired to the experiment.  

4. Once the experiment window is open and steps added, click Save Template.  

5. In the future, to run an experiment with the same parameters, click Recall Template.  

6. Once the parameters are adjusted to fit the experiment at hand, click Run Experiment to 
begin flowing air to the environmental chamber.  

7. Allow time for the humidity to equilibrate inside the chamber while watching the graph 
interface on the RH-200 software. To move from one step to another, click Next. 

8. To cancel the experiment before the last step has run, click Abort. 
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10.5 Heating and Cooling Sample Mount 

10.5.1 Proper Handling  

WARNING: Operation of the heating and cooling sample mount without proper water flow 
through the heat sink will cause permanent damage which will not be covered by the Bruker 
Corporation Warranty. 

The heating and cooling sample mount is comprised of a thermoelectric element (Peltier 
element), a thermocouple, and a water-cooled heat sink. Because of this, the stage has two water 
hoses and a cable bundle that need to be handled with care. See the images that follow for 
acceptable ways to handle the stage for install and removal. When storing the sample mount, 
place it in such a way that the cables are not placed under any inherent stress as this will 
eventually wear out the wires and cause the sample mount to fail.  

10.5.2 Connecting the Stage to the Interconnect  

Place the sample mount on the xy sample scan stage such that the kinematic mounts are 
connected properly and stable. Keep the cables and water lines free of snags and tangles and 
connect them to the proper locations in the Environmental Interconnect as seen in the following 
figure.  

 

Figure 10-4: The remaining connections for the environmental interconnect. The Water 
hoses are bipolar, and it is recommended to route them such that they are not 
mechanically restricted. 
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10.5.3 Pump Operation  
The heating and cooling sample mount uses a peristaltic pump to flow water from the ice water 
bucket, through a pulse dampener, to the sample mount and back again for recycling. The 
peristaltic pump has a removable pump head to facilitate the easy removal and replacement of 
the pump hoses in the case one has become irreparably pinched. The pump is bi-directional, but 
should only be run in the direction which puts the fluid through the pulse dampener before 
sending it to the sample mount.  

The ice water bucket must be filled to the yellow minimum fill line. Replace water as necessary, 
and empty the bucket if it will be unused for longer than one week to discourage fouling. If the 
heating and cooling stage will not be used for longer than one week, run the pump dry such that 
no more water comes out of the outlet pipe. Next, put the inlet pipe into a bottle of isopropyl 
alcohol and flush the system to displace any water left inside.  

IMPORTANT: The sample mount water connectors MUST be installed in the environmental 
interconnect as seen above BEFORE the pump is turned on. Failing to do so will result 
in pressurized water hoses resulting in a spray of water on the operator and possibly 
the system. In the event of hose pressurization as described above, disassemble the 
pump as described below to alleviate the internal pressure.  

If the pump will be left non-operational for more than two days, remove the peristaltic hose and 
re-install before use. To do this, follow these steps:  

1. Make sure the pump is not running and is unplugged. 

2. Use the supplied Cole-Parmer tool to unscrew the 4 screws holding the head in place.  

3. Remove the head assembly and separate the two halves to expose the hose and rollers.  

4. Gently remove the hose from between the rollers and the head being careful not to separate 
the hose from any pre-installed fittings.  

5. Place the two head halves together again and re-screw the halves to the peristaltic pump for 
safe-keeping.  

To resume experimentation, follow these steps to reinstall the hose to the pump head:  

1. Unscrew the four screws from the pump drive and hold the pump head and roller in one hand 
while removing the top half of the pump head.  

2. Hold the rollers still with your thumb while using the other hand to stretch the hose such that 
it will easily squeeze between the roller and the pump head shell.  

3. Repeat the above step 3x until the hose is squeezed between all rollers and the head shell.  

4. Place the top half back on the assembly making sure the two hose are properly placed in the 
channels and not pinched improperly between the two shell halves.  

5. Align the pump head assembly with the drive assembly making sure the flat section of the 
drive shaft fits into the keyed slot on the drive assembly.  

6. Screw the 4 screws through the holes in the head assembly into the drive assembly making 
sure the hoses come out of the top.  

7. Make a note of which hose coming out of the head goes directly to the pulse dampener and 
turn the pump on to rotate in a direction which will send water to the pulse dampener first.  
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8. Plug the stage into the Environmental Interconnect and make sure the supply and return 
water lines function as expected before beginning temperature control of the sample. If water 
is not flowing as expected, look for kinked or pinched water lines.  

10.5.4 Temperature Controller  

The heating and cooling sample mount is feedback controlled using a raspberry pi interfaced 
control box. The control box has the main menu, and the settings menu which is broken down 
into tabs. The tabs include general, stage, and graph.  

The Main menu shows the real-time temperature as read by a thermocouple housed in the 
sample mount. This screen is also where the user can adjust the desired setpoint for the stage 
temperature. One can touch the setpoint value and edit accordingly, or use the up and down 
arrows to change the desired temperature value. The  button in the top right of the screen 
turns the feedback on and the  button turns the feedback off as indicated by a red or green 
real-time temperature respectively. Red means the stage has not yet reached temperature 
whereas green means the stage has reached the steady state temperature as set by the setpoint.  

 

Figure 10-5: Each screen above represents the main menu in all states of the feedback 
loop followed by the Stage, General, and Graph tabs.  
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The bottom right of the screen shows a  button which takes you into a user interface which 
allows for the optimization of the feedback gains, adjustment of safety parameters, and the 
viewing of a setpoint vs real time temperature curve over time. Default gains have been 
previously loaded and stored onto the controller to ensure reliable performance over the entire 
temperature range. These defaults can always be re-loaded if the adjusted gains have hindered 
performance. To prevent the thermoelectric element from damage, the system is configured to 
shut down when the change in temperature of the stage exceeds 1 °C/s.  

To navigate back to the main menu,  placed in the bottom right of the settings menu. It is 
recommended to operate the stage in the main menu as it tells the user the most information of 
the real-time temperature and setpoint. 
 

Symptom Possible Cause and Solution 

Stage Temperature reads 
0°  

The stage is not making a reliable connection to the Controller. Check 
that all 6 pin connectors are firmly seated. If the problem persists, it is 
either a short or a disconnect wire. The user should also see a message in 
the bottom left stating “stage disconnected”  

Real-Time Temp does not 
reach the desired setpoint.  

Adjust the PID gains in the “Stage” tab to optimize the stage response for 
the desired temperature.  

Unexpected Stage 
Shutdown and error 
message  

If the stage unexpectedly shuts down and the controller shows an error 
message stating unexpected change in temperature, the stage 
underwent a large change in temperature indicating the lack of heat 
removal from the system. Make sure the hoses are properly connected, 
and the peristaltic pump is turned on. If the problem remains unfixed, 
consult Bruker Corporation for assistance.  

The stage remains at 100% 
power, but the real-time 
temp fluctuates 
unexpectedly  

Navigate to the graph tab. If the curve resembles a sine wave, the 
feedback loop is oscillating, and the gains must be optimized. If the curve 
resembles a sine wave that is sharply drops off, the op-amp inside of the 
controller is overheating. Check to make sure the fan in the controller is 
operating, and all vents are clear of obstruction.  

Probe will not engage when 
the stage is in feedback 
mode or the probe is being 
bent too much and the 
deflection is railed.  

The stage is thermally expanding or contracting causing either a false 
engage or too much deflection signal from the bending of the probe due 
to interference. To ensure proper AFM performance, make sure the 
system has had time to equilibrate once the setpoint temperature has 
been reached.  
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10.6 Heating/Cooling Operation – Quick Start 
The following quick start guide assumes that the user has already turned on the system and 
loaded a sharp AFM Cantilever. At this point, nothing but the necessary components for normal 
AFM operation are assumed to be turned on. The Environmental Chamber and Heater/Cooler 
sample mount pose higher risk to physical interference that may cause some extensive damage. 
Damage caused by incorrect sequence is not covered by the Bruker warranty. 

1. Plug in Heater/Cooler Sample Mount to Environmental Interconnect and place on the scan 
stage. 

2. Place the Environmental Chamber on the head and make sure the chamber is pushed as far 
forward and to the left as possible. 

3. Place a sample on the sample mount such that the mount does not stick out on any side of 
the sample mount. 

4. Switch Analysis Studio from “Normal” mode to “Env. Chamber” mode. 

5. Turn on the Peristaltic Pump, RH-200, and Temperature Controller. 

6. Load your desired AFM probe. 

7. Slide head all the way to the right, being careful to avoid snagging the rubber skirt. 

8. Use blunt nose tweezers to lift and position the metal skirt ring until it seats on the 
Environmental Chamber. 

9. Use the Load wizard to load the sample and approach the surface for measurement. 

10. Open the RH-200 Software and run the desired experiment to control humidity. 

11. Set the desired sample mount temperature and turn on the feedback loop. 

12. To improve drift and preserve the AFM cantilever quality, allow equilibration for at least 20 
minutes before engaging or scanning. 

13. Engage. 

14. Operate the NanoIR 3-s as one would without any added accessories.  

 

To finish an experiment or change cantilevers: 

1. Turn off Heater/Cooler stage feedback 

2. Withdraw and use the Unload function or Z stage arrows to drive the tip away from the 
sample as much as possible 

3. With the sample fully withdrawn, use tweezers to pull the skirt away from the environmental 
chamber 
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4. Slide the head to the left carefully paying attention to make sure the environmental chamber 
will not come into contact with the sample.  

5. Now it is OK to change the cantilever or sample. 

 

If you are finished with the experiment:  

1. Turn off the Temperature Controller, Peristaltic Pump, and RH-200. 

2. Remove the 3 connections for the heating/cooling stage, then remove the stage.  

3. Remove the Environmental Chamber. 

4. Store all parts in a designated location for safe keeping. 
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11 Facility Requirements 
This chapter provides information to assist in the laboratory space selection and facilities setup 
prior to installing a nanoIR 3-s system. Please email Bruker at Support.NanoIR@bruker.com for 
additional information on any requirements. 

11.1 System Space  
The nanoIR 3-s can be configured with a variable number of illumination sources. The space 
required depends on the number of sources used with the system. 

11.2 Air Table Requirements 
For a nanoIR 3-3 with 1 or 2 lasers, the recommended air table configuration is 3.25’ x 5.25’ (1 m 
x 1.6 m). However, larger footprint tables may be required for multiple laser configurations.  

 

Figure 11-1: nanoIR 3s with 2 QCL lasers 3ft/(0.9m) x 4ft(1.2m) table 

This table arrangement can support 2 QCL lasers, 1 FASTspectra OPO laser, and a laser switch. 
Note that 2 lasers require a 2-way laser switch; 3 lasers require a 3-way laser switch. 

11.2.1 Computer Table Requirements 

The table for the nanoIR 3-s controller/computer should be at least 3’ x 4’ (0.9 m x 1.2 m). There 
should be a 6” gap between the computer table and the isolation table. 

The computer table should be located to the right of the isolation table.  

mailto:Support.NanoIR@bruker.com


Air Table Requirements 

156 

11.2.2 Lab Access 

The entry door must have a 39” (1 m) opening to allow clearance for an air table of dimensions, 
3.25’ (1 m) wide x 4.25’ (1.3 m) to 6’ (1.85m). Larger table sizes may require a larger door opening. 

11.2.3 Weight  

The system weight for a nanoIR 3-s with a single laser is approx. 250 lbs., not including the weight 
of the air table. Air table weights vary by size and can be provided upon request. 

11.2.4 Floor Vibration 

The ideal vibration environment would be as follows, but a ground floor standard lab 
environment will function well. 

≤ 1 μm at 2 Hz  

≤ 2 μm at 3 - 9 Hz 

≤ 3 μm at 10 Hz 

The nanoIR 3-s system requires a vibration isolation system (3’ x 4’ air table, table top ¼x20 holes 
on 1” spacing or metric equivalent). Such tables can be purchased from Bruker as an option or 
separately sourced. 

11.2.5 Acoustic Noise 

The average measurement over a period of a few seconds should be <60 dBc. Higher levels of 
noise may negatively impact system performance. For loud environments, Bruker Nano Surfaces 
offers an acoustic hood. Please contact your sales representative for more information. 

11.2.6 Temperature 

Ambient temperatures should be in the 60 – 80 °F (15 – 27 °C) range. The change rate should be  
<2 °F (1.1 °C) per hour. It is best to position the nanoIR 3-s system away from any direct drafts 
from AC/Heating vents. 

11.2.7 Air Flow 

The air flow around or onto the nanoIR 3-s system should be less than 0.2 m/sec. 

11.2.8 Humidity 

The relative humidity (RH) in the space should be 20 – 80%, noncondensing. 

11.2.9 Cleanliness 

Do not locate the instrument in an area where excess dust can accumulate on exterior surfaces. 
Do not locate next to open windows or doors. Cleanliness better than ISO class 8 standard is 
recommended. 
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11.3 Connections 

11.3.1 Power  

Input power of <700 W, from a dedicated 120 VAC standard duplex outlet (15 amp). The outlet 
must have a dedicated grounding wire.  

Note: 100V or 220-240V are alternative configurations set at the factory. 

11.3.2 Power Fluctuations 

The nanoIR 3-s system is designed so that no damage to the system will occur during unexpected 
power shutdowns, or loss of compressed air. The system is CE certified; as part of this 
certification, it is tested for robustness to AC line power fluctuations and unexpected shutdowns. 
The system satisfies all requirements in this regard. 

11.3.3 Clean Dry Air (CDA) 

A connection for 0.25-inch polyflow tubing with a range of 0-60 PSI is required for the vibration 
isolation table. 

11.3.4 Dry Air Purge 

The nanoIR-3s system needs to be purged with dry air to minimize IR laser absorption due to 
water vapor. Either Clean Dry Air (CDA) or Nitrogen is recommended as a purge gas. Alternatively, 
an air dryer can be used. A suitable model is PureGas Model # CO2-PG14. 

For all purge gasses, 5-20 scfh (2-10 l/min) of gas flow is required. A flow control valve or 
regulator is recommended for flow adjustment (not included with the system). 

11.3.5 Liquid Nitrogen 

The MCT detector used for s-SNOM operation requires cooling with liquid nitrogen (LN) for 
proper operation. You should supply a Funnel <6 mm OD & a Dewar flask 

11.3.6 Argon Gas for Sample Transfer (Purchased Option) 

The nanoIR 3s sample transfer chamber (option) for inert sample environment requires a supply 
of Argon gas. Full facility details can be provided prior to installation.  

11.3.7 Environmental Chamber (Purchased Option) 

If purchased, the Environmental Chamber option has the following additional requirements.  

• Input Voltage: separate electrical power supply of 100-240 VAC (2 plugs) 

• Input Air Requirements: >20 psi of nitrogen or Compressed Dry Air 

• Water Requirements: Distilled water 
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11.3.8 Heater Cooler & Sample Mount (Purchased Option) 

If purchased, the Heater Cooler option requires an electrical power supply. 

• 100-240 VAC (2 lines)  

• Distilled Water and Ice if temperatures below -10 °C are required. 

11.4 Setup and Pre-Installation Notes 
The customer must set up the air table before the nanoIR 3-s system installation can begin. We 
request that the air table be in place before the Bruker installer arrives. Depending upon table 
size, a forklift may be required for table placement. 

The top surface of the air table must be electrically grounded to the electrical AC main ground 
used in the laboratory.  

A computer desk or table is not supplied by Bruker as part of the system and will need to be 
provided by the customer. Place this desk or table adjacent to the air table.  

11.5 Product Safety Standards 
All Bruker nanoIR products are designed to meet national and international standards and 
regulations for ergonomic and safe operation. All products are CE certified based on the following 
standards: 

• EC-Directive: 2006/95/EC (Low Voltage Directive) 

• Harmonized Standard: EN 61010-1: 2001 Safety requirements for electrical equipment for 
Instruments measurement, control and laboratory use – General requirements 

• EC-Directive: 2004/108/EC (EMC – Directive) 

• Harmonized Standard: EN 61326: 2013 Electrical equipment for measurement, control and 
laboratory use.  

11.5.1 Additional Certifications 

The nanoIR 3s system has passed specific field certifications from nationally recognized test labs 
such as CSA and TUV. The option for field labelling can be provided at additional cost. If additional 
certification beyond CE is required, please contact your sales representative to discuss further.  

11.5.2 Laser Safety 

The nanoIR 3-s systems are designed with laser safety control integrated into the system.  

• During normal operation, users are protected from exposure from all internal lasers such that 
the laser class of the product is FDA Class 2. 

• The system is designed to be used with one or more external Bruker-supplied lasers. 

• For lasers purchased and installed through Bruker, the combined system of the external laser 
and the nanoIR 3-s product is FDA Class 2, unless noted otherwise. 
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• For customer-supplied external lasers, it is recommended that the facility be evaluated by a 
laser safety expert to ensure that the alternate source and beam path meet any applicable 
laser safety regulations and requirements. Bruker Nano Surfaces is not responsible for this. 

• The nanoIR Broadband laser is a Class 4 laser but is classified as a FDA Class 3R when 
integrated with the nanoIR 3-s-Broadband System. 

11.6 Training & Annual Maintenance 
Bruker Nano Surfaces provides training for safe instrument operation. This training highlights 
specific safety-related issues. Additionally, Bruker offers optional annual maintenance visits to 
verify the set up and condition of the instrument. 

11.6.1 Documentation 

The following user documentation is provided when the system is installed: 

• This nanoIR 3-s User Guide, which provides comprehensive information on system use, safety 
information, tips and tricks. 

• NanoIR facilities and installation documentation 

• Documentation and manuals for 3rd party sourced systems, such as lasers, lock-in amplifiers, 
and vibration isolation tables. 

11.6.2 nanoIR 3-s PM Checks 

Preventive maintenance check should be performed according to the following schedule: 
 

Frequency Check to perform 

Daily IR background check 
AFM probe changeover and laser adjustment 
LN2 refill for MCT Detector - As needed 

Weekly None 

Monthly AFM calibration check 

Quarterly Check chiller water level 

Annual Laser and system re-alignment 

11.6.3 End of Life 

At product End-of-Life, the system electronics—computer, monitors, nanoIR controller, circuit 
boards within the system, IR source, etc.—should be disposed of according to local regulations. 


